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cards and PC cards.



Chapter 1
Try It! ZoomBrowser EX

Starting ZoomBrowser EX (1/4)

This chapter covers the ZoomBrowser EX basics, such as starting the
program, downloading images from the camera and printing them. It
begins with the procedures for starting the program.

4

IMPORTANT

e This guide assumes that all the relevant software programs and
drivers have been correctly installed on your computer. If they
have not been installed yet, read the guides that accompanied
your camera and install them before proceeding further.

ZoomBrowser EX Software User Guide

Starting Methods

There are two ways to start ZoomBrowser EX: “Starting by
Connecting the Camera to the Computer” and “Starting by
Clicking an Icon or Menu.”

It is generally easier and more convenient to start it by
connecting the camera to the computer.

However, you may wish to click an icon or menu to start it

under the following circumstances.

e \When you are using a memory card reader.

e \When you wish to use ZoomBrowser EX without connecting a
camera.

* When you are restarting ZoomBrowser EX with the camera
still connected after the program has been closed once.

IMPORTANT

* \With some versions of Windows, you may not be able to use
the “Starting by Connecting the Camera to the Computer”
method the very first time the camera is connected to the
computer after it is booted up (owing to a limitation of Win-
dows). In this case, start ZoomBrowser EX with the “Starting by
Clicking an Icon or Menu” method. You may use the camera
connection method from the second time onward.
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Starting ZoomBrowser EX (2/4)

Starting by Connecting the Camera to the Computer

1.

5

You can start ZoomBrowser EX with this method by attaching
the camera to the computer and preparing it to transfer data.
Set the following Auto Start Settings the first time (only) that
you connect the camera to a computer. If you have already set
them, proceed to the steps on the next page.

IMPORTANT

e This method can only be used when the camera is connected to
the computer with the interface cable.

M Settings for the First Connection to a Computer

Use the interface cable to connect the camera to the
computer.

Please see the manual supplied with your camera for
connection instructions.

With some models, the camera may need to be set to the
playback mode to communicate with a computer. Consult the
manual for these models to set the camera to the correct mode
for communication.

A dialog similar to the following one (Events dialog) will appear.
If it does not, read the Troubleshooting section in the
Appendices.
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Your camera model name or
“Canon Camera” will appear here.

Select [Canon CameraWindow] and click [OK].

Click [Set].

Once you click the Set button, this dialog will no longer appear
when the camera is connected.
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Ty ¢ ZoomBrowser EX Starting ZoomBrowser EX (3/4)

M Procedures for Subsequent Connections to a Computer 7. Usethe interface cable to connect the camera to the
computer.
IMPORTANT : .
.......................................... Please see the manual supplied with your camera for
* With some versions of Windows, you may not be able to use connection instructions.
this method of starting ZoomBrowser EX the very first time the With some models, the camera may need to be set to the
camera is connected to the computer after it is booted up. (The playback mode to communicate with a computer. Consult the
dialog shown to the right will not display even if you connect manual for these models to set the camera to the correct mode
the camera to the computer correctly.) for communication.
In this case, start the program with the Starting by Clicking an
Icon or Menu method. A dialog like the ones below will display.
REFERENCE -
e If the Scanners and Cameras Wizard displays, close it and use LRl = kel
the Starting by Clicking an Icon or Menu method to start ampr— A
ZoomBrowser EX. ok, T v , =)
e A device selection dialog will display if you have both a camera HiFrin
and a memory card reader connected at the same time. Confirm B s e
that your camera model name or [Canon Camera] appears in L e e et e VIS e s i i
the list box and click [OK]. —

The procedures from this point onward are described in the
next topic, “Downloading Images to a Computer”.

Click [Browse Images with ZoomBrowser EX] if you wish to
proceed to ZoomBrowser EX's main window and do not wish to
download images.

The explanation about which method is used to download
images after ZoomBrowser EX starts up automatically is
contained in the “Auto-Download Settings” section of the
Appendices.
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Try It! ZoomBrowser EX

Starting ZoomBrowser EX (4/4)

Starting by Clicking an Icon or Menu

Use the following methods to start ZoomBrowser EX using its
desktop icon or a menu.

M The Icon Method

1_ Double-click the [ZoomBrowser EX] icon on the desktop.

=

ZoomBrowser
Ex

ZoomBrowser EX will start and open its main window.
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Main Window

The procedures for downloading images are described in the
next topic, “Downloading Images to a Computer.”
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1.

B The Menu Method

Click the [Start] menu and select [All Programs] or
[Programs], followed by [Canon Utilities],
[ZoomBrowser EX] and [ZoomBrowser EX].

ZoomBrowser EX will start and open its main window.

B demsinrmmn 10 L odisopeses ser Senivgs Buesma My lisarernimily Sreee e

Main Window

The procedures for downloading images are described in the
next topic, “Downloading Images to a Computer.”
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Downloading Images to a Computer (1/4)

This section describes two methods for downloading images shot with
a camera to a computer.

B Downloading Images with Computer Commands
This method uses commands entered on the computer to

download images from a memory card in a camera or in a
memory card reader. This method can be used regardless of

whether your camera supports the direct transfer function or not.

B Downloading Images with Camera Commands
You can use this method to download images with cameras

that support the direct transfer function.

Check to ensure that the computer and the camera or memory

card reader are in the correct state for communication.

Using Computer Commands to Download Images

1.

8

Read the dialog that displays.

If a dialog similar to the one below appears, proceed to Step 4.
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your camera model.
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Proceed to Step 2 if ZoomBrowser EX’s main window displays.

Click [Camera & Memory Card].
L

i wail et g Blyhador Wy [ poiis e iy Fosies s R

Sk Hall

?5-}{..:_; Tl

) -
If you are using a memory card reader, check to ensure that the
card is correctly inserted in the reader.

Click [Browse & Download Images].
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Ty ¢ ZoomBrowser EX Downloading Images to a Computer (2/4)

REFERENCE

e A dialog will appear if multiple memory card readers are con-
nected and loaded with memory cards, or if a camera and a
memory card are connected concurrently, to allow you to select
which images are shown from which device. In that case, select
the desired device from the list box and click [OK].

4_ Click [Start Image Download].
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REFERENCE

* You can view information such as the destination folder for
images by clicking [Show Current Settings] in the window.

e By the default setting, the program downloads all the images
that have not yet been downloaded.

The images will begin to download. The downloaded images
will be saved into folders according to their creation dates.
When the download is complete, the downloaded images will
appear in the main window.
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Try It! ZoomBrowser EX

Downloading Images to a Computer (3/4)

Using Camera Commands to Download Images

10

You can download images using camera commands if your
camera supports the direct transfer function (camera has a
Print/Share button &),

Read the dialog that displays.

If a dialog similar to the one below appears, proceed to Step 2.
The Print/Share button will light up at this point and a direct
transfer menu like the one shown at the lower right will appear
in the camera’s LCD monitor.

Oirect Transfer
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IMPORTANT

® The camera’s Print/Share button cannot be used to download
images if it is not lighted.

REFERENCE

e The dialog in step 1 will not display if the Camera Window or
RemoteCapture Task window is open. Please close these win-
dows.

e A dialog will appear if a camera and a memory card reader are
connected concurrently to allow you to select the device from
which images are shown. Select the desired device from the list
box and click [OK].

St Camera (Semury Card
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Downloading Images to a Computer (4/4)

2.

11

The image transfer will commence after you set the
direct transfer setting on the camera.

REFERENCE

* See the Camera User Guide for the settings and procedures
related to the Direct Transfer menu shown on the camera’s LCD
monitor.

® You can also download images by clicking the [Start Image
Download] button on the program window on the computer
instead of clicking the camera’s Print/Share button.

® You can view information such as the destination folder for
images by clicking [Show Current Settings] in the program
window on the computer.

* By the default setting, the program downloads all the images
that have not yet been downloaded.

The images will begin to download. The downloaded images
will be saved into folders according to the shooting date.
The images will display in the main window when the
download is complete.

ZoomBrowser EX Software User Guide
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Chapter 1
Try It! ZoomBrowser EX

Printing Images (1/6)

You will use the PhotoRecord printing utility to print.
REFERENCE

* Images recorded in the Adobe RGB color space will appear
unsaturated when printed using PhotoRecord. (Color space
settings are only available on select camera models.)

e Please see the PhotoRecord Help menu for more details on using
this program.

9. Click [Print].
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2. Click [Layout Print] in the next menu.
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Select the images you wish to print and click [Next].
The background of the selected images will turn orange.
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e More than one image can be selected by clicking on successive
images. To deselect an image, click it a second time.
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Printing Images (2/6)

4.

13

Place a check mark in the boxes of the data you wish to
include with the print (multiple selections are possible)
and click [Finish].

REFERENCE

* See Viewing Image Properties in Chapter 4 to learn how to
append comments to images.
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This will start PhotoRecord and display the print image in the
album window.

REFERENCE

e |f the PhotoRecord Guide displays at startup, read it as neces-
sary.
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To operate PhotoRecord, follow the procedures displayed at the
window’s left.
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Printing Images (3/6)

K. Click [2 Select Printer & Album Type] and select a
printer and an album type.

Select a printer

R

o i g 1Y i v

Select an album type

Detailed settings for each album type
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REFERENCE

* Select among the following album types. (The displayed album
types may vary according to the printer in use.)

® One Photo Per Page/One Photo Per Sheet
Prints one image on each sheet of paper.

® Free Form
Allows images to be freely positioned on the page and
printed.

e Contact Sheet
Prints image thumbnails and their shooting information (Exif
data) in a table format. The shooting information displayed in
ZoomBrowser EX and the Exif data that can be printed using
PhotoRecord differ slightly.

* Fixed Size Photo
Prints images at the heights and widths you specify.

* Mosaic
Prints a specified number of images in a spread.

e Perforated Paper
Prints images on perforated paper.

e 8-Sticker Label
Prints images on 8-label sheets.

e After you have selected the album type, you can set the detailed
parameters for each album type in the area below, such as the
margin placement and width and the number of images in an
arrangement.
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Try It! ZoomBrowser EX Printing |mag€S (4/6)

6_ Click [3 Select Paper] and choose the media type, /. Click [Decorate Album] and change the image back-
paper size and paper orientation. ground, frame and other design elements as desired.
Media Type and Paper Size Settings Select an item to change
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Select a design

REFERENCE REFERENCE

* The settings categories shown in this window may vary accord- e The items that can be changed include the themes (a unified
ing to the printer in use. design for the background, photo frames and text frames, etc.)
backgrounds, photo frames, text frames, and clip art.
e Select the target page, image or text first when choosing a
background, photo frame or text frame.
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Try It! ZoomBrowser EX Printing |mag€S (5/6)

&. Click [Add Titles & Captions] and change or add titles
and text as desired.

Click on text that is already displayed to change it.

Select the text.

Edit it here.
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To add new text, click the target page and input the text.

Select the page
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Input the text

REFERENCE

* You can also adjust the font, font size, justification and color as
desired.
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Printing Images (6/6)

9. Change the size and rotation angle of the image, text
or clip art as desired.

The following operations can be performed in the album
window.

M Move Items
You can move images, text or clip art by dragging them.

B Change Size or Rotation Angle

You can change the size or rotation angle of images, text or clip
art by dragging the following points on them.

1
_.-l
=

'TT“] Tt 54 AN |

Sets it to the state at the left
(sizing mode)

&)

You can change the
size by dragging
one of these points.

Sets it to the state at the right
(rotation mode).

You can change the rotation
angle by dragging this point.
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10 Click [4 Print], confirm the number of copies and
other print settings and click [Prlnt]

4
. -
ﬁ | ..I? h “
Vi B FEEAL | BT A
B - "N

> |

Wi
l

This starts the printing process.

To close PhotoRecord, click the
menu and select [Exit].

REFERENCE

(close box), or click the [File]

* Images captured by cameras that support the Exif 2.2 standard
(nicknamed the “Exif Print” function) have the shooting settings
data, such as the shooting conditions and shooting mode,
embedded in them. You can obtain better prints by using this
data to correct and print the images.

* PhotoRecord automatically performs image correction (default
setting) on images shot by cameras that support the Exif 2.2
standard and on other image types, providing you with better
print results.
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Ty It ZoomBrowser EX Supplementary Information

In this section, we explain information that you should know to use
ZoomBrowser EX.

If You Have a Problem

ZoomBrowser EX comes with a Help file. Use it when you want
to learn how to do an operation, or when you want to know
about the features of the program.

You can access Help from the [Help] menu or the [?] (Help)

button.
Help menu
-
ZoomBrowser EX - C:\Documents and Settings'Myname'\My Docur
File Edit “iew Tools Intermet Camera
ZoomBrowser E¥ Help.,,  Fl | 'E
Help Faor » i
B abouk ZoomBrowser EX...
R M CrOCTImET s =" —I h‘-
B o [T My bMuszic Bty |

n— Help button

Exiting ZoomBrowser EX

You can exit ZoomBrowser EX by clicking 3 (Close button) on
the Browser Window. Alternatively, select [Exit] from the [File]
menu.
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e What Can ZoomBrowser EX Do? (1/2)

This chapter explains the basic skills required to master ZoomBrowser EX. Use the file management features to:
Let's begin with an overview of the main features. :

e Categorize, sort and manage image files on your computer
with easy procedures.

e Move or copy images.

e Perform simple editing such as cropping images or adjusting
their colors.

e Create and edit movies, adding various effects: link movies
and still images, superimpose titles and other text, and add
background music.

e Run a slide show displaying the images in sequence in the
full-screen mode.

Connect the camera to your computer to:

e Download images from the camera to your computer in an
easy procedure.

* \View an index of the images from the camera on the
computer monitor.

e \/iew information (shooting date and camera settings) about
images stored in the camera.

e Use your computer to set up slide shows or DPOF print
settings (not available on some models).

e Save computer images onto your camera.

e Operate the shutter of a camera connected to a computer via

an interface cable to take pictures remotely, or to perform e Save the My Camera Settings in the computer to the camera
interval timer shooting after specifying an interval and the or vieNcut?

number of images to be taken (only on models supporting e Handle newly created images and sounds as My Camera
remote shooting). Settings

e Convert RAW format images (change them to the TIFF or '
JPEG format and resave them). Adjust the brightness, REFERENCE

contrast, color and other settings as you convert them. (Some S ST
camera models do not support RAW images.) e The start-up image, start-up sound, shutter sound, operating
' sounds and self-timer sound are collectively called the My

Camera Settings.

® The Canon CD-ROM supplied with your product contains several
prepared My Camera Settings files. These files are automatically
copied to your computer when you install ZoomBrowser EX.

Use the My Camera Settings function to:
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e What Can ZoomBrowser EX Do? (2/2)

By using other programs:

ZoomBrowser EX gives you additional power when you use it
together with the following applications. (You can start these
applications from within ZoomBrowser EX.)

M PhotoRecord

e You can use this program to create and print beautiful
layouts consisting of multiple images.

e You can select frames and backgrounds with a variety of
designs.

® You can add text to images or pages.

* You can create original image albums.

M PhotoStitch

e You can stitch multiple images (which were split and shot
individually using functions like the camera’s Stitch Assist
mode) together to form a single, large size, panoramic picture.

* You can stitch images horizontally or vertically.

e |f you shoot the surroundings in 360 degrees, you can later
stitch the images to form a 360-degree cylinder. By saving
this stitched image in QuickTime VR format, you can then get
a virtual view of the various parts of the image.
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Wt s ZoomBrowser EX Finding Images and Folders (1/2)

It is important to understand how folders are used in ZoomBrowser EX
to store images.

Where Are Images Stored?

Use the following procedures to find out where image files are
stored on your computer when they are downloaded from the
camera.

1_ Click the Windows [Start] menu and select [My
Pictures].

Windows 2000/Windows Me/Windows 98 users should double-
click the [My Documents] folder, followed by [My Pictures].
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The images that you downloaded in Chapter 1, Downloading
Images to a Computer, should be contained in the My Pictures
folder. As you will note, the folders mentioned above also
appear at the right of the ZoomBrowser EX window.
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If you double-click the folders appearing in the Windows screen
shot at the left, you will find image files and folders with the
same names as those displayed in the ZoomBrowser EX
window.

As this demonstrates, when you open a particular folder in
ZoomBrowser EX and download images to it, or move images
between folders, these changes are also happening in the
corresponding folders shown by the Windows operating
system.




Chapter 2
What is ZoomBrowser EX?

Finding Images and Folders (2/2)

Folders in the Browsing Area and Folder Area

22

Image thumbnails (tiny versions) are shown in the right-hand
side of the ZoomBrowser EX window. This area is called the
Browsing Area. The area in the middle, called the Folder Area,
shows the folder directory much as it is shown in Windows
Explorer.

The Folder Area shows all the folders on the computer. The
orange colored folder is the currently selected folder. The
images inside this folder are what are shown in the Browsing
Area.
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Folder Area Browsing Area
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Folders within Folders

You can create folders within folders, adding successive levels
to provide detailed categories that make it easy to find and use
your images.

1ents and Settings\Myname'

‘a Help

FOLDERS

B MY Dezkiop
— ty Dlocuments

Example of folders within folders
for categorizing images

=3 Local Dizk [C:)

REFERENCE

e Instructions for creating folders are included in Chapter 4.

IMPORTANT

* In ZoomBrowser EX 4, image files in folders within the Program
Files folder (saved using ZoomBrowser EX 2 or 3) will not display.
To display these images, follow the procedures in If You Were
Using ZoomBrowser EX Version 2 or 3 of the Troubleshooting (2/
4) section.
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This window is designed for managing images downloaded to the Switching to the Camera Window
computer. It can also be used for various functions, such as printing and
sending images by e-mail. To switch to the Camera Window, click the [Camera & Memory
i i Card] task button, followed by [Browse & Download Images] in
Main Window Components the next menu.
Path of the selected folder
(Word String describing the |0cation) B Pammibtresnsr L8 . G rllurumen pud S esia g Myneme 8y Decipes oty 1oy e e 13 o =

Ths i Bes Cwl  Inbevel  Cawes by

T L | . ,_ g | i 4
5 bt i ‘A Frambes B - |— Function Buttons
e sl B9 o 3 Ll ceeid | ; Buttons that perform various
-(I;aSktAreath  uttons —— il o functions on the images in the
ontains the buttons for

Browser Area.
frequently used tasks. P

— Browsing Area

Displays the image thumbnails (tiny
versions) and folders contained
within the folder selected in the
Folder Area.

Folder Area

Displays all the folders in
the computer. Use this area
to select folders that
contain images.

* Images recorded in the Adobe RGB color space will appear
unsaturated when displayed in ZoomBrowser EX. (Color space
settings are only available on select camera models.)
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Task Area and Task Buttons

The Task Area contains the four task buttons: Camera &
Memory Card, Print, View & Modify and Internet. Click one of
these buttons to perform the related task.

B Camera & Memory Card

Click this to open the Camera Window or perform remote
shooting.

M Print
Click this to print images.

M View & Modify
Click this to display images in a slide show or edit them.

N Internet
Click this to attach images to e-mail messages.

When you click one of these buttons, the corresponding
submenu to the right displays.
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e SEES —a

REFERENCE

e To return to the main window, click [Return to Main Menu] at
the bottom of the menu.
* To switch from one task to another, click the appropriate icon

g ﬂ ﬂ E to the right of the task button.
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Using the Task Windows M Gray Buttons

When you select a task from the menu, all of the steps in that Tasks ‘Ejhatkare selecr:]tablehat the time are cplorled gdray. The kytton
task display in the task area turns dark gray when the mouse cursor is placed over it. You
' can switch between tasks by clicking another task button.
M Orange Button However, if you have already f|n|shed selectlng an image anql you
His col ks th I he i . nth switch to the [Select Captions for Printing] task, you must click
This color marks the current step. Follow the instructions in the [Select Images] again to reselect the image.
right-hand side of the window to proceed. When you have e T ey
completed the step, click the [Next] or [Finish] button at the o et g g : vy

|
STEF I Sstwid sapioia ot phhirg |

bottom right of the window to proceed to the next step.
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b Vot o ko i sfch b sech rroge are o of of e peopae el B Elew

it | agbwre I
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M Grayed Out Buttons

Grayed out buttons indicate tasks that are not available at the
time. When you finish the task underway, the buttons will once
again become selectable.

Fyir | i Fum

Frigan o Her M

B tvamEimwwr 0N L Pacamsss and Berimas Syvams i Decem sei iy Fiass 29 oW L I ERE

e Pl e R e SR —

57 1 7] L"I'1-nj phart B |

G GRG0 E e LCh

REFERENCE

e Click [Previous] to return to the prior step.
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Chapter 2

What is ZoomBrowser EX?

Main Window (4/5)

Function Buttons

The following buttons are available in the main window.

a'

e

il

Ter
{6

©

E

View Mode Button

Switches between the scroll mode, zoom mode and
preview mode according to the context.

Thumbnail Size Button (scroll mode only)

Selects the size of images displayed in the Browser
Area.

View Image Button

Displays the selected image at a larger size in the View
window.

Properties Button
Displays information about the selected image.

Rotate Button
Rotates the selected image. Choose between 90° left,
90° right or 180°.

Delete Button
Deletes the selected image from the computer.
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Chapter
buttons.

Zoom-In Button (zoom mode only)
Zooms in on images or folders in the Browser Area.

Zoom-Out Button (zoom mode only)
Zooms out from images or folders in the Browser Area.

Up Button
Advances one step up from a lower level folder.

Select All Button
Selects all the images and folders in the Browser Area.

Clear All Button

Deselects any images or folders selected in the Browser
Area.

s 3 and 4 explain more about the task and function
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What is ZoomBrowser EX? Main WindOW (5/ 5)

Changing the Display

M Hiding the Folder Area
You can hide the Task Area and Folder Area to make the Click the 3 button in the upper right of the Folder Area to
Browsing Area larger.

hide it and make the Browsing Area larger. Click the €2 button
to redisplay the Folder Area.
M Hiding the Task Area

Click the €3 button in the upper right of the Task Area to hide

it and make the Browsing Area larger. Click the €3 button to
redisplay the Task Area.
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B W e D et e el

_!- H-IE_IF W-‘WMH-‘HM L

I-Iil.tm.-m..-lnr-rlr- =

M-

TV S

E'I-L!E.El I"'""""B i:"""!l

[ o W el o

A
! Basenlliimanes L m-dqummng
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l n - ““ E ﬁi
E= ) ‘ * You can also hide the Folder Area by clicking the [View] menu
::l-l:ln-'ll [T D002 Y | P j s .
REFERENCE

selecting [Folder Area] and removing the check mark beside it.,
* Both the Task Area and Folder Area can be hidden at the same
time.
® You can also hide the Task Area by clicking the [View] menu,
selecting [Task Area] and removing the check mark beside it
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I — Camera Window (1/2)

The Camera Window is used to view images contained in the camera
(memory card) and to select and download images to a computer.

REFERENCE

* Images recorded in the Adobe RGB color space will appear
unsaturated when displayed in ZoomBrowser EX. (Color space
settings are only available on select camera models.)

* Methods for displaying and using the Camera Window are
explained in Chapter 5.

Camera Window Components

28

Close button

Click 4 to switch back to the
main window.

BT i 1 e

Lapany | Momewp L

Task Area Function Buttons
Contains buttons for Buttons that perform various functions on the
frequently used tasks. images in the Camera Window.
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Task Area and Task Buttons

The Task Area contains the four task buttons: Download
images, Print, View as slideshow and Connect to internet. Click
one of these buttons to perform the related task.

M Download Image
Downloads the selected images to the computer.

M Print
After the selected images have been m
downloaded to the computer, this button starts -
the printing process. A submenu like the one to L=:

the right appears when you click this button. L _ﬁ!
[y W :Fﬂ‘_:i
M View as Slideshow as

After the selected images have been downloaded to the
computer, this button displays the Setup Slide Show window.

M Connect to Internet

After the selected images have been
downloaded to the computer, this button starts
the process for creating e-mail attachments. A
submenu like the one to the right appears when -
you click this button. -

Tewrd o o mead

m-
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REFERENCE
.......................................... Deselect Button

e To switch from one task to another, click the appropriate icon
Fh) at the right of the task button.
ﬁl J n E 188 Rotate Button

Function Buttons Rotates the selected image. Choose between 90° left,
90° right or 180°.

Deselects a selected image.

The following buttons are available in the Camera Window.
| Delete Button

11| Set Button Deletes the selected image from the camera (memory
Sets various settings, such as those for connecting to a card).
camera. The following items are included in the .
i
submenu. & P.ropert.les Buttpn |
Recornect Displays information about the selected image.
Camnir i SeLtings
Srda DPOF
Pyl Y .3 Help Button
= Displays the help dialog.
Select Button Chapter 5 explains more about the task and function buttons.

Selects images for further processing with other
functions. Various selection methods can be chosen
from the submenu.

St Al

Skt Plaiy

Skt Prick mark
Sebact Serd mark
Seleit Shde Show mark
Irveert Sedection
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Chapter 2
What is ZoomBrowser EX?

Using the Right-Click in Operations

With ZoomBrowser EX you can access many useful functions by using
the right mouse button (right-click).

30

For example, if you right-click a thumbnail, the following
shortcut menu appears.

m Fagrullimens £ . [0 Maceimoais vl Setioes Hynasin by lis wresary By Plmmosa JB0 B 0 L= BL
O o - i

Right-click anywhere on the image to display a shortcut menu.

A shortcut menu is a convenient collection of the most
common window buttons and menu commands that apply to a
given situation.

ZoomBrowser EX Software User Guide

The right-click allows you to use ZoomBrowser EX more
efficiently. After you become familiar with ZoomBrowser EX, try
right-clicking in many situations and you will be impressed with
its convenience.

Note that, in general, this manual does not cover operations
using the right-click. (This is because explaining many shortcut
menu variations would take too many pages of this manual.)
However, there are a few operations that are only accessible by
right-clicking. These operations are described on the
corresponding pages.




Chapter 3

i s Selecting Folders - Folder Area

This chapter explains how to view and edit images in ZoomBrowser EX. Collapsing and expanding a folder
In this section, you will learn how to use the Folder Area to select
folders with images that you wish to view. If a folder contains subfolders, you can use the [E] and

. buttons to collapse or expand the folder. When you click the [=]
Selecting Folders button to collapse the folder, its subfolders are hidden. When
Click a folder in the Folder Area to view its contents in the you click the [ button to expand the folder, its subfolders are
: displayed.
Browsing Area.

Click [=]to collapse a folder. Click [+]to expand a folder.

Selected folder Images from the selected folder display (if there % S x
are folders within the selected folder, those B [l
folders and their images are shown within a rr—'-"‘ itfein
folder-shaped border). 213 My s
: i '1” dhe _'| | 5
| Ay [ =] -\.._-.;_: _'-_I.J -
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Chapter 3
Viewing Images

Selecting Folders - Browsing Area (1/5)

This section explains how to use the Browsing Area to open folders and
search and view images.

Selecting a Display Mode

32

The Browsing Area features three display modes: the scroll
mode, zoom mode and preview mode. The zoom mode is the
default mode. To switch between modes, click E (View Mode)
and choose an option from the menu that appears.
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* You can also switch between display modes by clicking the
[View] menu and selecting one of the scroll mode, zoom mode
or preview mode options.

e In scroll mode, you can change the image thumbnail size by
clicking the (Thumbnail Size) button (or by clicking the
[View] menu and selecting [Thumbnail Size]) and selecting a size
from the menu.
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B Zoom Mode

Zoom mode displays all the images in subfolders as well as the
selected image folder.

|| Images within nestled

folders also display (a
folder-shaped border
indicates a subfolder).

N
REFERENCE

e The procedures for changing the zoom speed are explained in
the Customizing Preferences (1/3) section of the Appendices.

e |t can be difficult to find a particular image when you have a
multitude of folders and images. In this situation, you can use
the Zoom mode to find a particular image by viewing all the
folders and picking the most likely one to contain it.




Chapter 3
Viewing Images

Selecting Folders - Browsing Area (2/5)

B Scroll Mode M Preview Mode

Scroll mode only displays the images in the selected image folder
to show them at a larger size. A scroll bar will appear on the right
side of the Browsing Area if all the images do not fit at once. If the
image folder contains subfolders, only their icons display.

e A 1111 e ~— Scroll Bar

Images in subfolders
_J do not display.

ZoomBrowser EX Software User Guide

This mode displays one image at a large size and information
about the image.

Select the image to preview from the bottom of the Browsing
Area. You can also switch between preview images using the
[Next] and [Previous] buttons.

— Displays various
! image information

Images within the
folder do not display

Switches between the Click an image to preview
next and previous images it at a larger size




Chapter 3

T Selecting Folders - Browsing Area (3/5)

Selecting Folders

B Zoom Mode

In the Browsing Area, double-click an area where there is no
image inside the folder you wish to see. The contents of the
folder are displayed in the Browsing Area.

b
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Double-click inside the
- | 4 desired folder to zoom
MTEEes— 00 Jon Ggtents

By repeating this step, you can go deeper and deeper into the
folder hierarchy.
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B Scroll Mode

In the Browsing Area, double-click the icon of a displayed folder
to view its images and subfolders.

If a folder icon is not shown on the
screen, click the scroll bar to display it.
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4 Double-click a folder
TR to view its contents.

By repeating this step, you can go deeper and deeper into the
folder hierarchy.
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A Selecting Folders - Browsing Area (4/5)

B Preview Mode Returning to a higher level in the folder hierarchy
At the bottom of the Browsing Area, double-click the icon of a , _
displayed folder to open it and view its images and subfolders. When you are deep in the folder hierarchy, you can use the

(Up) button to go back to a higher level.

The example below shows the zoom mode, but the procedure
is the same for the other display modes.

rerm e rmds el e By e Sy e | e - . TN

Double-click the folder
icon to display its
images and then click
on one to preview it.

By repeating this step, you can go deeper and deeper into the

folder hierarchy. n
e | o Click the [Up One
= Level] button to
4 zoom out the folder
| at that level.
4
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Chapter 3

T Selecting Folders - Browsing Area (5/5)

In Zoom mode, you can do this M Right-Clicking to Zoom In or Out

Right-click on any clear area in the Browsing Area to display a

menu like that below. You can zoom an image or folder in or

out by selecting the respective [Zoom In] or [Zoom Out] option
from this menu.

There are more convenient ways to use the Zoom mode.

B Zooming in by skipping levels

You can zoom in directly on a subfolder displayed in the Browsing B s
Area without going through each successive level by double- _— - e
clicking within the folder (on a point containing no images). i e iall <t o)
ilml‘m = e 1 B 4= L s
:I_"- L} [ g L . [ieer 8
G S
H 1= = Double-click this area to
HE B iiEarn sl | skip the Samples folder
S and zoom in directly on
—_— the Flower folder.
s | e | v
EEE - . i 4::-"{41
o " -
f E.i - ‘;'. # i . : .
I - o .. O

REFERENCE

* You can get the same result by using the [View] menu. Click a

M Using the Zoom-In or Zoom-Out Cursor folder. Then, on the [View] menu, click [Zoom In] or [Zoom Out].

Click in the function buttons to change the mouse cursor
into a magnifying glass. You can then zoom in on a folder or
image in the Browsing Area by clicking it with this cursor. Click
the button to zoom out.
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A Opening Images

This section explains how to open images displayed in the Browsing Area. REFERENCE
How to open an image * After selecting an image, you can click g (View Image) to open
the image.
In the Browsing Area, double-click the image that you want to * You can also open an i.mage by selecting it, clicking the [View]
open. The image appears in a new window. menu and selecting [View Image].
muen sl SeEwporre- iy Froemere By e SR O 0 LS . . .
- : —— Opening multiple images
el 2 1 7
bt i & B Continue to double-click successive images or hold down the
8= [Shift] key while you click on successive images. Then click
K o (View Image) to open all the images simultaneously.
| e — Double-click the image
o iy you want to see. REFERENCE
Rk ey Sy b W e e

* A confirmation dialog will display if you attempt to open more
P— than five images at one time.

Closing an image

Click £ (Close button) on the image window to close the
image.
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e Zooming

This section explains how to zoom an image. Scaling to the window size

How to select a zoom ratio You can scale the image to fit the window size. From the zoom
ratio list, click [Scale to Fit]. The image is adjusted to the size of

Click the =] at the bottom of the window to open a submenu the window.

and click an option to change the display to that zoom ratio.
Bl it i Sty Ry By e i By e R

The mouse cursor changes to an arrow when you place it
here. Click and drag in this state to change the window size.

Txg'ng a zoom ratio

You can display an image at a ratio you set by typing a value in
the zoom ratio box and pressing the [Tab] or [Enter] key.

L | Choose a zoom ratio from :
?;;_-_i the list. S i'_“ﬁ—_ll -
.iEﬂL |

Enter a value (%) and press the [Tab] or [Enter] key.
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A Editing Images (1/4)

This section explains how to edit an open image. Using the edit panel, you can perform the following editing
. operations.
Edit Panel Features
M Crop
An edit panel for revising images displays beneath images that Crop the image, cutting out parts that are not needed.

have been opened. _
M Color, Brightness, Contrast

Change the image appearance by adjusting color density,
brightness, and contrast.

gﬂ"ﬂﬂm._ﬂ W“H“" i izabrri i ki Wil FHIJrI'I'I.m...! E [

B Undo, Redo

Undo or redo the previous editing operation. This allows you to
try various changes until you are satisfied with the image.

M Save As

After you have modified an image, you may want to save it
under a different name. This function allows you to do so.

See the following pages for detailed descriptions of these
functions.

Edit Panel
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A Editing Images (2/4)

M Crop

Use this function to extract only part of an image, leaving out
unneeded portions.

Place the mouse pointer within the image you want to crop.
Click and drag to form a rectangular frame. Then, click
(Crop) to extract the area within the frame.

i i il kg . i 1 i o P 1 o B O

@ Drag to frame the area
for cropping.

O Click this >

button.

40 ZoomBrowser EX Software User Guide

REFERENCE

* You can drag any of the anchor points B located along the
frame to adjust the size of the area for cropping. Also, if you
want to change the position of the whole frame, place the
mouse pointer within the frame and drag it.

Drag the anchor points
M to adjust the size of
the area for cropping.

Drag within the frame
to adjust position of
the frame.




Viewing lmages Editing Images (3/4)

Color, Brightness and Contrast REFERENCE

* You can adjust the color (saturation), brightness and contrast by
entering a value in the box beside the slider and pressing the
[Tab] or [Enter] key.

You can adjust the color (saturation), brightness or contrast by
dragging the respective slider in the edit panel.

Increase color saturation

>

Decrease color saturation

<

Increase brightness

Increase contrast

>

Decrease contrast

<
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A Editing Images (4/4)

Undo, Redo

After you edit an image, the result may not satisfy you and you
may want to go back to the previous step. In this case, click
(Undo) to cancel the operation and return to the previous step.
Keep clicking E (Undo) to continue going back. If you feel
that you have undone too many steps, you can reverse it by

clicking ﬂ (Redo).

Save As

After you have modified an image, you can save it under a
different name so that the original image remains intact.

Click [Save As] to display the Save As dialog. Type a new name
and specify the kind of file and the image quality. Then, click
[Save].

Click this button.
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Overwriting the original image

After you have modified an image file, you can save it under
the same file name (overwriting the original image). In this
case, click [Save As]. When the Save As dialog box appears,
type the same name as the one of the original image. (To find
out the name of the original image, check the title bar of the
image window.)

REFERENCE

* After you have modified an image, if you click &4 (Close button)
without saving the changes, a message appears to prompt you
to save the edited image.

!:; EnamEirwmns EX

?'J The megethas been mocifed. Do you want En sevs k7

l.__ —_— ‘I.-'

To save the changes, click [Yes]. When the Save As dialog box
appears, type a name and specify the kind of file and the image
quality. Then, click [Save].

If you do not want to save the changes, click [Cancel].




Chapter 3

Viewing lmages Editing Images with Other Programs

This section explains how to edit an image selected in ZoomBrowser EX How to edit an image with other programs

using another image editing program that has been registered with

ZoomBrowser EX. Click [View & Modify] in the main window, followed by [Edit
REFERENCE Image] in the next menu.

© Select an image.

e |f you installed the image editing program included with your [ Sosipltiinwes £, : GOt o ""-*"-"*""W""L""""m-“-" A=
product (contained on a CD-ROM other than the Solution Disk),
it should automatically be registered in the ZoomBrowser EX
menu.

e The procedures for registering programs are included in the
Image Editor Tab section of the Customizing Preferences (2/3)
topic in the Appendices.

@ Click this.
This will start the image editing program and open the selected
image in it.

REFERENCE

* You can also open an image after you have selected it by
clicking the [Edit] menu and selecting [Edit Image].
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Chapter 4

Organizing Images Cl’eating FOlderS

This chapter explains how to manage images effectively with
ZoomBrowser EX. It starts with the method for creating a new folder
within an existing one.

Creating Folders

1.

2

44

Select a folder in the Folder Area.

You will be creating a new folder within the folder selected
here.
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Click the [File] menu and select [New Folder].
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3.

Type a name for the new folder and click [OK].
You have created a new folder.
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Chapter 4
Organizing Images

Selecting Images

This section explains how to select images in the Browsing Area.

Selecting a Single Image

Click on an image to select it. The background color of the
selected image(s) will change to orange.
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REFERENCE

* To deselect an image, click it again.

Selecting Multiple Images

45

To select more than one image, continue clicking on successive
images. You can select a series of adjoining images in one step
by holding down the [Shift] key while you click the first and last
images.
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Selecting All the Images

Click ZeaEes i (Select All) at the top of the Browsing Area to
select all the images in a single step. You can also click the
[Edit] menu and choose [Select All].
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REFERENCE

o Click JEEERZINN (Clear All) at the top of the Browsing Area to
deselect all the images at once.

* You can also deselect all the images at once by clicking the [Edit]
menu and choosing [Clear All].

® You can change the selection methods to standard Windows
selection methods. See the Selection Tab topic in Customizing
Preferences (2/3) in the Appendices.




Chapter 4

A Moving or Copying Images (1/4)

This section explains how to move or copy images between folders. It is
convenient to conduct these procedures in the zoom mode.

REFERENCE

* Moving or copying images in ZoomBrowser EX affects the actual
location in which those images are stored on your PC.

I I

Moving an image in the Browsing Area

You can move an image in the Browsing Area simply by using a
drag-and-drop operation.

E H o
—cat

5 fEnen

e |

e ' '
il (TS L T A | ‘ x r'l-- ™ n A
: | e*d @ Drop it at the

| FELAED . | L desired location.

O MG

2

win_ifTkJen

© Drag the image you
want to move. >
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A Moving or Copying Images (2/4)

Copying an image within the Browsing Area

To copy an image, before you drop the image you are dragging,
press and hold the [Ctrl] key and release the mouse button,
while still holding the key.

i iyl fiEn e

o
=T ]
.‘- =
I"I.

WO (T | G T

A

@ While holding down the [Ctrl] key,
drop it at the desired location.

@ Drag the image you >
want to copy.
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A Moving or Copying Images (3/4)

Moving or Copying an Image from the Browsing Area to the Copying by Dragging a File Icon from a Windows Window

Folder Area _ NP
You can also copy an image by dragging its file icon from an

You can move or copy images between different folders by open Windows window and dropping it onto the ZoomBrowser

dragging them from the Browsing Area to the Folder Area and EX window.
dropping them in the target folder.

Wi e R =

ottty "SI J

| T, A

Drag the image

L Lous Db : T (1)
. l S - E e < you wish to move.
: | i o I

—— @ Drop it in the target folder.
@ Drop it in the target folder.
REFERENCE
.......................................... REFERENCE
.TO COpy an Image from the |mage folder you are in at the .......................... . e o o o o o 0o o 0 s o o e . .
moment to a different image folder, proceed the same way: * On the other hand, when you drag an image from the Browsing
Hold down the [Ctrl] key before dropping the image and release Area of ZoomBrowser EX to Windows Explorer, the image is
the mouse button while holding the key over the target library. automatically copied.
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Moving or Copying Images (4/4)

Additional ways of moving or copying images M Copying from the menu

Select one or more images, click the [Edit] menu and select
[Copy]. Next, select the target folder in the Folder Area, click

B Moving or copying many images at once , , aer
the [Edit] menu and select [Paste]. (This operation is not

You can select several images by clicking them in succession.
You can also select a series of adjoining images in one step by
holding down the [Shift] key while you click the first and last
images.

available with Windows 98.)
REFERENCE

* You can select all the folders or images displayed in the Browsing
Area at once by clicking [IEEEETII (Select All) at the top of the

Browsing Area or by clicking the [Edit] menu and selecting [Select
B Moving or copying a complete folder Alll.

In addition to moving or copying individual images, you can
move or copy an entire folder. In the Zoom display mode, select
the folder by clicking inside it where there are no images. Then
move the folder by dragging and dropping it, or copy the folder
by first pressing down and holding the Ctrl key, and then
dragging and dropping the folder.

Display modes and folder selection procedures are explained in
Selecting Folders - Browsing Area in Chapter 3.

Once the images are selected, you can move or copy them all
together with standard drag and drop procedures.
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Chapter 4

A Deleting Images (1/2)

This section explains how to delete images that you no longer need.

How to delete an image

Click the image you want to delete, and click ﬂ (Delete).

m Hiwrnllinansi £, - DD eis sl e le Synasin By Do By Plm e st Vi s BT
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@ Clickanimage. @ Click [Delete].
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Click [Yes] when a confirmation dialog like the one below
appears.
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REFERENCE

------------------------------------------

e |f you accidentally delete a required image, double-click the
[Recycle Bin] icon on the Windows desktop to open it. Select the
image and, in the Recycle Bin Tasks section, click [Restore this
item]. (With Windows 2000/Windows Me/Windows 98 in web
page view mode, select the image and then click [Restore this
item back to its original location] at the left side of the window.)
When you switch back to ZoomBrowser EX and click the [View]
menu and select [Refresh Current Folder], the image will
reappear in its original location.
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A Deleting Images (2/2)

Other ways of deleting images

M Deleting multiple images

You can select several images by clicking them in succession or
by holding down the [Shift] key while you click the first and last
images in a series. When you have selected all the images that
you want to delete, clicking || deletes all of the selected
images at once.

M Deleting images from the File menu

Click an image. Then, click [Delete] on the [File] menu to delete
the image.

M Deleting an Entire Folder of Images

This procedure is explained later in this chapter in the Deleting
Folders topic.

REFERENCE

* To completely delete images from the computer after
completing the procedures above, double-click the [Recycle Bin]
on the Windows desktop to open it and, in the Recycle Bin Task
section, click [Empty the Recycle Bin].

(With Windows 2000/Windows Me/Windows 98 in web page
view mode, click [Empty Recycle Bin] at the left side of the
window.)
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Organizing Images

Rotating Images

This section explains how to rotate images to the desired orientation.
This is useful for images taken by holding the camera sideways.

IMPORTANT

* By the default setting, rotating an image in ZoomBrowser EX
changes (rotates) the image in the file on your PC.

How to rotate an image

52

Select an image and click H (Rotate). Select the direction of
rotation in the next menu.

m Feigrullinaans: IY . [ g uimisgb ereld Sotiorm Hpnadic By liei wieay By P ra ] stme P L B
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Select an image to rotate and click to specify the direction.
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REFERENCE

* 90-degrees left is a counterclockwise rotation and 90-degrees
right is a clockwise rotation.

e There are two methods for rotating images. With the default
setting, the original image is rotated.

* To set the rotation settings, refer to Rotate Tab of the
Customizing Preferences (3/3) section.

Other ways of rotating images

M Rotating multiple images

You can select several images by clicking them in succession or
by holding down the [Shift] key while you click the first and last
images in a series. When you have selected all the images you

want to rotate, select a rotate option to rotate all the selected
iImages at once.

M Using the Menu to Rotate Images

You can also rotate an image by selecting it, clicking the [Edit]

menu, selecting [Rotate Image] and choosing the direction of
rotation.
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Renaming Images

This section explains how to rename images.
IMPORTANT

Renaming an image in ZoomBrowser EX renames the actual file
on your PC.

REFERENCE

* Because an extension (indicating the type of the file) is
automatically assigned, do not include an extension in the
name. (In the file named [xxx.JPG], for example, the [.JPG]
portion is called the file name extension.)

Using the Rename Function

Select an image, click the [File] menu and select [Rename].
The Rename Image dialog box appears.

@ Click an image to rename.

1] hﬂhlm Y, - harssmstt sl Setiam Synass By lissreas iy

EE v G WTE LETEE el

@ Click [Renamel.
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A dialog similar to that below will appear.
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Type the new name and click [OK] to change the name of the
image. You can also rename a sound that is attached to an
image.

Using the Preview Mode

If you click £ (View Mode), choose [Preview Mode] from the
next menu and select an image, you can change the name of
that image.

ﬁ‘.ﬁ--h—nr- CotpmEs b bae g s ey s S e s e e L i AR

| T I T - P———

O e

|ty Pt ]




Chapter 4

Organizing Images SOrting |mages

This section explains the procedures for changing the image order. M By Name
i Sorts images in alphabetical order by the file name.
Sorting Images
M By Type
To change the image order in the Browsing Area, click the Sorts images in alphabetical order by the file type.

[View] menu, select [Arrange] and then one of the sorting

options. M By Date
T - Sorts images in order from the oldest modification date to the
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Click [Arrange] and select a menu item.
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Organizing Images

Searching Images (1/3)

This section explains how to perform searches on images.

Searching Images

55

You can search for images marked as Favorites or search by
such parameters as the modification date, shooting date or
keywords. The procedures for marking images as Favorites or
adding keywords to them are explained in the following pages.

Select a folder to search in the Browsing Area.

Click [Select All] to search all of the images and folders
displayed in the Browsing Area.

Click [View & Modify], followed by [Search] in the
next menu.

|- R U - B S e 4
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i R e e e By By e e B e or L R

Set the search parameters.

I R R e e e e L R qw |

i -
T e o w
Lﬂ - i & oo ——— Sets whether images
| s Iyt are searched

according to all the
parameters or just
one

Clicking here allows
you to hide the
search parameters

Set the search parameters here.

First, place a check mark in the parameter you wish to use.

Next, if you selected the modification or shooting date, set the date range.
If you selected the keyword option, select the keywords.

Click [Next] after you have set the parameters.

A set of images corresponding to the search parameters will
display.
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Searching Images (2/3)

5_ If the search results are satisfactory, click [Finish].

If you wish to modify the search parameters, click [Previous]
and repeat steps 3-4.

- [ R

— Images satisfying the
search parameters

This concludes the search process.

Images satisfying the search parameters will display in the
folder named “Search Results” in the main window.

You can select and print these images, or copy them to other
folders. These images will remain registered in the Search
Results folder until you close ZoomBrowser EX or perform
another search.
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. images satisfying the

Lol ol A 4 Py search parameters
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Adding Keys for Image Searches

¥ Adding the Favorites Symbol to Images

It is easier to find your favorite images if you mark them with a
Favorites symbol. The Favorites symbol is shown below.

o

w Favorites Symbol

G OmoET Lt R

L

T I L

There are several methods to mark your favorite images. Use
any one of the following procedures after you have selected
one of your favorite images in the Browsing Area.

e Click the [Tool] menu and select [View/Modify keywords].
Click to place a check mark in the [Favorite Photo] option in
the next window.

e Click H (Properties) and click to place a check mark in the
[Favorite Photo] option in the next window.

e Click E (View Mode) and select [Preview Mode], then select an
image and place a check mark in the [Favorite Photo] option.

e Click the F77 symbol at the bottom right of the window that
displays while a slide show is playing.

A=A
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Searching Images (3/3)

Adding Keywords to Images

57

Add keywords to images for use in searches.

Select the image in the Browsing Area.

Click H (Properties) and [View/Modify keywords] in
the next window.

Instead, you can also click the [Tool] menu and select [View/
Modify keywords].
A window for setting keywords will display.

Click to place a check mark beside a keyword.

| Place a check mark
beside a keyword

"o
To add a new keyword, type it in the
) box at the left and click [+].
Click [OK].

This concludes the keyword settings process.

ZoomBrowser EX Software User Guide

Managing Keywords

The following window displays when you click the [Tool] menu
and select [Manage keywords].

-

You can use the following functions in this window.

B Add Keywords
Type a new keyword in the box beneath the list and click [+].

B Delete Keywords

Click to place a check mark beside the keyword to delete and
click [Delete].

M Restore Keyword List

This function restores the keyword list based on the images
assigned keywords. This can be used when you deleted a
keyword that was used in the past but want it back.




Chapter 4

Organizing Images REffESh i ng FOlderS

This section explains how to refresh or update a folder.

What Does It Mean to Refresh a Folder

Adding, moving, copying or editing an image or a folder within
ZoomBrowser EX ensures that it is updated and appears
correctly in the Browsing Area.

However, the information ZoomBrowser EX possesses and the
actual file contents can be different when an image file is
moved or copied using Windows functions or edited with a
separate program.

In this case, the “current state of the folders” has to be
checked and updated. This is what is meant by refreshing a
folder.
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Refreshing Folders

Click the [View] menu and select [Refresh Current Folder]. This
will update ZoomBrowser EX's information about all the folders.
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Click [Refresh Current Folder].




e Deleting Folders

This section explains the procedures for deleting folders. Click [Yes] in the confirmation dialog to proceed.
IMPORTANT & Coafirm Fobibei Dalabe x|
e \When you delete a folder, all the actual images and folders it 2 tew vou s o veart b debets the fokler o'
contains are deleted too. -
Deleting Folders

Select a folder to delete and click u (Delete). Alternative Method

m 3“-1-\_ !.H_ - R i H-J.“ﬂlnﬁ.!'hnﬂl iy limi itorn 1 Big Flrmises L B

e : e 3 i ] B Using the Menu to Delete
¥ ot Ll You can also delete a folder by selecting it, clicking the [File]

- | menu and selecting [Delete].
TN T
e REFERENCE
[ =] = S e ;! - e To completely delete folders from the computer after
BEEe | - - completing the procedures above, double-click the [Recycle Bin]
on the Windows desktop to open it and, in the Recycle Bin Task
e - section, click [Empty the Recycle Bin].
Lol Elng (With Windows 2000/ Windows Me/Windows 98 in web page
[ — =1 I view mode, click [Empty Recycle Bin] at the left side of the
BO “ P window.)
n | |des |

Select the folder and click [Delete].
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Organizing Images Renaming FOlderS

This section explains the procedures for renaming folders. A dialog similar to that below will appear.
IMPORTANT I Hemamn Faolilme
e When you use ZoomBrowser EX to change a folder name, the E;:“""
name of the folder on the computer disk also changes to that

name. e —

Renaming Folders
g Input a new file name and click [OK] to set the name.

Select a folder to rename, click the [File] menu and select
[Rename].

B Pasrsliinass: £, . DORRrsisash sl St lo Uy Wy s s By Pimioss [ ED
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After you select the folder, click [Rename].
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Organizing Images Finding Folder Locations

This section explains methods for finding out which disks and folders A window similar to that below will appear.
contain your image folders. You can check the location of the saved folder by looking at the
o ] categories below.
Viewing Folder Properties B Proportes =]
Select the folder and click [ J (Properties). Modfed 31542003
Fibe= i
m h!"'F. | R 1 pq.iﬂl-dn.ﬂrhiﬂl iy L iaresin Mg Flimii fa L™ Suibd e 1

He B e Do rETEr Canes el

S

Path: C:\Documents s Sealing s Mynama
Iy D oomen ety el Piciupsa’s

| Foldes Hame

Fooweer .

Click the & (Close button) to close the window once you have
checked it.

Alternative Method

M Using the Menu to View Folder Properties

Select the folder and click [Properties]. You can also find out where a folder is located by selecting the
folder, clicking the [View] menu and selecting [Properties].
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Chapter 4

A Viewing Image Properties (172)

This procedure is for viewing various information about the selected image.
REFERENCE

e \WWhen an image taken by the camera is modified and saved by

another program, information about the camera settings might
be lost.

Viewing Image Properties

Select the image in the Browsing Area and click H (Properties)
to open the Properties window.
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[ R P i (The information in this area will vary
&R according to your camera model.)
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If you click on another image in the Browsing Area while this
window is open, the displayed data will switch to that of the
new image.

This window can be used to check the date an image was
revised, the file size, the image size, the file type, the file location,
the shooting date and time and other detailed information. You
can also use it to change the file name and type in comments. To
close the Properties window, click its £ (Close button).

REFERENCE

® You can select several images by clicking them in succession or
by holding down the [Shift] key while you click the first and last
images in a series. Then you can click (Properties) to view
the properties of each image in succession. Use the [Previous]
and [Next] buttons to switch between the information for each
image.

* You can also view image properties by selecting the image,
clicking the [View] menu and selecting [Properties].
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A Viewing Image Properties (2/2)

Alternative Method

You can view the properties of an image by clicking the ||
(View Mode) menu, selecting [Preview Mode] in the next menu
and selecting the image.

You can check the file name, comments, histogram and
detailed shooting mode settings in the image properties
window. You can also change the file name and add comments

to the image.
v - S & - -
II:JII_-l oy e
i - — File Name
i - =
== — Comments

You can set settings
for use in searches

+~ Histogram

— _ (graph showing the
' ‘ distribution of

brightness data)

Shooting Information
(The information in this area will vary
according to your camera model.)
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Chapter 5

using the camerawindow  OPENING the Camera Window (1/2)

This chapter explains how to use ZoomBrowser EX's Camera Window. IMPORTANT

It starts with the procedures for opening the window. o s Tt
e ZoomBrowser EX may not start with the previous method the

Connecting the Camera and Opening the Camera Window first time a connection is established after the computer is
booted up when some versions of Windows are running. See

A dialog similar to the following one will appear when you the Starting ZoomBrowser EX section of Chapter 1 for details.

connect the camera to a computer using an interface cable and
prepare the camera to communicate. If you select [List Images],
the Camera Window will display.

M o Camiada i colinaicbed 1o His camgiobe
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Camera Window
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Chapter 5
Using the Camera Window

Opening the Camera Window (2/2)

Using the Task Buttons to Open the Camera Window

IMPORTANT

e Ensure that the camera and computer are connected with an
interface cable and are ready to communicate before you
perform this procedure.

e |f you are using a memory card reader, ensure that the memory
card is loaded into the reader before performing the procedure.

Click [Camera & Memory Card] in the main window and
[Browse & Download Images] in the next menu.
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A window like that below will open.
Click [List Images] to open the Camera Window.
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Click here.
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Using the Camera Window DOWHlOading |mages (1/3)

This section explains the procedures for downloading images from a
camera (memory card) to a computer disk.

Downloading Images

Select the image(s) and click [Download image].

Select the image(s).

Click here.
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Specifying the Image File Destination

Specify the location to which your image files are downloaded

on the computer.

D ndoad Setfings El
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Specify the folder to
which images are saved.

Select this option to stick
the downloaded images
in a new folder created
within the one specified
above. Then select a
naming option for the
new folder to the right.

If you selected the [Set as new] option,
type in a folder name here.

If this option is left unselected, the image file names are the same as those
in the camera (file names assigned by the camera at the time of shooting,
such as "IMG_XXXX.JPG," where the “Xs" represent numbers). If you select
this option and type in a root file name, the name becomes something like

"ROOT+XXXX.JPG."”
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Using the Camera Window DOWHlOading |mages (2/ 3)

REFERENCE Alternative Method

® The My Pictures folder is set as the default destination.
B Downloading Multiple Images
You can select several images by clicking them in succession.

Once the images are selected, you can download them all
together in a single step.

Click [OK] to start downloading. When the download is
complete, the Camera Window will close and the main window
will open.

The Camera Window after Downloading ® Selecting Images for Downloading

Images that have been downloaded are marked with a Click E (Select) to open the selection menu, which contains
“downloaded” symbol like that below. the following options.

-
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This symbol indicates that the image has been downloaded. Vi e e |50

Hﬂtdr:hﬂtﬁnnm‘;:d‘m.- Seiect Pk meark
Smiar | Sare ok ——
Safiect Sheke T mark
[rveeet Sebaction
e Select Al
Selects all the images in the camera (memory card).

e Select New
Selects only the images that have not yet been downloaded
to the computer.

e Select Print mark
Selects only the images that have be marked with print
settings by the camera.
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Using the Camera Window

Downloading Images (3/3)

68

e Select Send mark
Selects only the images that have been marked with transfer
order settings by the camera.

e Select Slide Show mark
Selects only the images that have been marked with slide
show settings by the camera.

e |nvert selection
Deselects selected images and selects the previously
unselected images.

REFERENCE

e [f an image is taken in the Stitch Assist mode, it appears in the
Camera Window as follows:

Mark indicating an
image taken in the
Stitch Assist mode

(You can start

PhotosStitch by
clicking the line with
arrow heads.)
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e [f an image is taken in the RAW mode (some camera models do
not come with this feature), it appears in the Camera Window as
follows:

Mark indicating n

an image taken in
the RAW mode

e [f an image is taken in the Movie mode, it appears in the Camera
Window as follows:

Mark indicating
Movie

e If an image has a sound memo attached (some camera models do
not come with this feature),it appears in the Camera Window as
follows:

Mark indicating a
sound memo
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Using the Camera Window DElEting |mageS in the Camera

This section describes how to delete images from the camera (memory Other ways of deleting images
card).

IMPORTANT M Deleting multiple images

You can select several images by clicking them in succession.
When you have selected all the images to be deleted, perform
the deletion. All the selected images are deleted.

e Please note that deleting an image in the Camera Window
deletes the actual image from the memory card. Since deleted
images cannot be recovered, be extremely careful when using

this function. M Selecting images for deletion

How to delete an image in the camera Click =i (Select) to display the selection menu, which can be

_ used to select the images for deletion.
Select the image you want to delete and click L8] (Delete) to
delete it.
@ Select an image.

B aeiid i | il

{ amany § Mg |

@ Click here.

When a message appears, click [OK]. The image is deleted.
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Using the Camera Window ROtating |mageS in the Camera

This section explains how to rotate the display of images stored in the REFERENCE
Camera tO the des'red Orlentatlon ----------- crtee e e
* 90-degrees left is a counterclockwise rotation and 90-degrees
9 e The Rotate function affects only the image displayed in the

In the Camera Window, select the image you want to rotate. Camera Window. The image stored on the camera is not

Click JE3 (Rotate) to display a menu. On the menu, click the changed at all. However, when you download the image, the
rotation angle that you want to Use ' image is rotated and saved on the computer in the correct
' orientation.

© Select an image.
Other ways of rotating images

BT e 19 | e

Lawuny | Hemmnyp g

B Rotating multiple images

You can select several images by clicking them in succession.
When all the images are selected, perform the rotation
operation. All the selected images are rotated at once at the
same rotation angle.

@ Click here.
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Chapter 5
Using the Camera Window

Adding Computer Images to the Camera (1/2)

This section explains the procedures for copying images from the
computer disk to the camera (memory card).

How to copy an image to the camera

71

Click JEH (Set) and select [Add Image(s)] from the next menu.

BT e 19 | e

1 awan g b Mrmmp |

Click here.
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A dialog box appears. In the dialog box, select an image you
want to copy to the camera and click [Open].

REFERENCE

e You can upload multiple images in the same operation.

If a dialog similar to that below appears, select an option as
required and click [Add]. This will upload the image to the
camera.

il dl o

Il =l b ] e el o o ]

v dedmegn min Select this to upload the
image to the camera
T without resizing.

Add  Cancl |

Select this to resize the image before uploading it to the camera.
Select the image size in the list box beneath. (With a memory
card reader, the image size is input as numerical values. If [VGA
Size] is selected, 640 and 480 appear automatically.)




Chapter 5

usng the camerawindow - ACIAiNG Computer Images to the Camera (2/2)

REFERENCE

® You can select the [Add image as is] option only when
uploading JPEG images based on the DCF standard. Select [Add
image after adjusting size] for all other images.

* JPEG format images can be uploaded to the camera.

* RAW format images and movie files (AVI format) cannot be
uploaded to the camera.

e File formats are explained in more detail in the Supported File
Formats topic in the Appendices.
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using the camerawindow  USING the Task Buttons (1/2)

This section explains the tasks that can be performed with the task Download Destination Dialog
buttons that weren’t mentioned in the downloading topic.

When you select an image in the Camera Window and click a
Task Buttons task button, a dialog like the one below will appear. Specify the
destination folder to proceed with the next part of the task.

Select a task from the four buttons available.

[ ndood Sattinps

St LD e doeiliaibig

S o [k
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Fricet rzmim i Shoging deis
[cmeninaded dale

i~ Get s now

™ Diemignets prefis of mage b be saved
Fis preks

[ o= ]| cocst |

Downloading Images (1/3) in this chapter explains how to
specify a download destination.

IMPORTANT

* The selected images are downloaded to the computer each time
a task button is selected in the Camera Window and then the
tasks are performed on them.
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sing the camerawingow  USING the Task Buttons (2/2)

Selectable Tasks

The procedures after a download destination has been specified
are the same as below.

M Download Image

These procedures are explained in Downloading Images in
this chapter.

M Print
e Layout Print

e Contact Sheet Print
This procedure is described in Printing Images in Chapter 1.

M View as Slideshow
® These procedures are explained in Running a Slide Show in
Chapter 6.

B Connect to Internet

e Send Images in E-mail
These procedures are explained in Sending Images by E-mail
in Chapter 6.
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Chapter 5

using the camerawindow  OtET Functions of the Camera Window

This section explains the additional functions of the Camera Window
that you can use.

= CameraWindow

Camera & Memory Card

Download image (pal

View as shdeshow 205

Connect to internet

Finished collecting images for display. T tal: 12 irﬁages

Click here to deselect images. Click this button to check Image
Properties information.

On the [Set] menu, select [My Camera] to display the My Camera
window, which can be used to change the start-up image, shutter sound
and other camera settings (these procedures are explained in Saving the
“My Camera Settings” to the Camera section in Chapter 6). *

You can reconnect the camera after its connection to the
computer has been interrupted by selecting [Reconnect] | L __
from the [Set] menu.

You can play a slide show using the camera or set the

DPOF print settings by selecting [Slide/DPOF] from the You can check and change camera settings by clicking the [Set]
[Set] menu. (These procedures are explained in Setting Up button and selecting [Camera Settings]. This procedure is described in
Sllde ShOWS on the Camera and Print Sett’ngs n the Checking and Changing Camera Settings in Chapter 6.

Appendices.) *

* Some camera models do not support this button.
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Chapter 6

using supplementaryFeatures 9ENAING IMages by E-mail (1/2)

This chapter explains how you can use images stored in ZoomBrowser EX 4 Set the image size and image quality settings.
in various situations. First, let’s begin with how you can send images in -
e-mail. Use this option if you do not want
to change the size of the image.
IMPORTANT T
.......................................... Specify the reduction ratio relative to Use this optl_on if you \{vant to
e To use this function, your e-mail program must be set up as a the original size of the image. reduce the size of the image.
MAPI client. For detailed information on how to set up your e-
mail program, refer to the documentation that comes with it. B A L L -
How to send an image by e-mail : o
I T — o mew of gl Fvague L S
1 Click [Internet] in the main window. A ek —|
w Thorae Imiags e ) Pem s arg cwrprern reagen e BEE vl —
2. Click [Email Images] in the next menu. [ B . -y

£ Esiiam @ percer ol sagead

B Sl T g ek of crwEnan

3_ In the Browsing Area, select the images you wish to

Ear= S ITL £ Fagsh ity

send and click [Next]. M

You can select multiple images or a folder and have the images ot b e e feACE

in the folder included in the e-mail attachment. : futs wan of changed srumgee unape TS

BT
The window will change to the image size and image quality B W o gt i i TG s ok b el B
. . B oy wvwad § wn & nin' fs spe @ TERT] o8 rec grerniwil

settings window. i
Specify the image quality. Use it to check the file size when you
(The lower the quality, the rougher actually compress the image. (The
the image becomes, but the size of file is displayed in the “Total size of
the file also becomes smaller.) changed images” category.)

Use it to check the image quality as it will appear
when compressed. (A preview image will display.)
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S:i:nzt:lr::plementary Features Sending |mag€S by E'mail (2/2)

5_ Click [Next]. 7_ Click [Finish].
) e |f You Selected [Create a new email]:
Select whether to create an e-mail message or save Your e-mail program will start and the selected images will
the images. appear as an attachment in the message window. Input the

address, subject and your comments and send the message.

Start the e-mail program and send
the e-mail immediately. Wl How Message Y fi=l

Fie Eft  Wew Trsmt  Fomad Took  Message  Help i
m Feigtulliaans LY . [0 Nep il vl §otiorn Bymadin By e ity By Pl rad st [ BT L]
i |.r v DOl WTETE  ETeE el - = g | w
B - Besl e erewd i oes i o pwd lelii Sencd Pinia ke
@ |
N P A ﬂcf i
I t:lll::'l-‘i-::".. ':-' :Tllll ll -' .I'lll' M Al et R g Eean H-rg-r r
| Alkich: | NG 0001 1 PG (5.0 68)
n-:l—llll- :'-c:.:nlr: !:-::-: 3w fhomagh 3 o pr g
e |f You Selected [Save the images in a folder to send through
an email program]:
P The images will be saved to the specified destination. To send
Bl The ruagen s 5 Srai R i the images by e-mail, start your e-mail program and attach
the saved image files to a message.
REFERENCE
| * You can also send images by e-mail by clicking the [Internet]
© Figniis Fwaip | . .
i . e menu and selecting [Send Images by Email].
Save the image on If you selected [Save the images in a * Some e—ma|l programs might not bg able to start aultoma’ucally
the disk first. folder to send through an email (those without MAPI support). In this case, save the image to the
program], click [Browse] to specify a disk, start the e-mail program and attach the image to an e-mail
destination. message.
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Chapter 6

using supplementary reatwres - ACIING Computer Images to the Camera (1/2)

This section explains the procedures for copying images from the
computer’s disks to the camera (memory card).

IMPORTANT

e Ensure that the camera and computer are connected with an
interface cable and are ready to communicate before you
perform this procedure.

e |f you are using a memory card reader, ensure that the memory
card is loaded into the reader before performing the procedure.

Adding Images to the Camera

9. Click [Camera & Memory Card] in the main window.
2_ Click [Upload Images] in the next menu.

3_ In the Browsing Area, select images and click [Finish].

You can select multiple images or a folder and have the images
in the folder included.

4_ Resize the image as required and click [Add].
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Select this to upload the
image to the camera
without resizing.

Select this to resize the image before uploading it to the camera.
Select the image size in the list box beneath. (With a memory
card reader, the image size is input as numerical values. If [VGA
Size] is selected, 640 and 480 appear automatically.)

The Camera Window will open and the specified images will be
added to the camera (memory card).

[ i ool g mae e e

REFERENCE

e [f multiple images have been selected, then the selected resizing

option will affect all the selected images.




Chapter 6

using supplementary reatwres - ACIING Computer Images to the Camera (2/2)

REFERENCE

® You can select the [Send image as is] option only when
uploading JPEG images based on the DCF standard. Select [Add
image after adjusting size] for all other images.

* JPEG format images can be uploaded to the camera.

* RAW format images and movie files (AVI format) cannot be
uploaded to the camera.

e File formats are explained in more detail in the Supported File
Formats topic in the Appendices.
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Chapter 6

Using Supplementary Features EXpO rti ng | m a g ES (1 / 2 )

This section explains how to change the size, resolution or file format of Exporting Images
a selected image and write it to a new file, and to export an image for
use as a screen saver or wallpaper. It also describes how to export the

shooting information to a text file. 9. Click [View & Modify] in the main window.
Export Formats 2. Click [Export Images] in the next menu.
The following types of image export formats are available. 3_ In the Browsing Area, select images and click [Next].

You can select multiple images or a folder and have the images

W Edit Images and Resave in the folder included.

You can change the file format and/or image size and save it to

a new file. Select one of three file formats: JPEG, TIFF or 4. Select an export option and click [Next].
WlndOWS Bltmap (BMP) YOU can alSO add |dent|fy|ng .m.klllu.r‘:}-l U Mimaiepe it geil Sotisaga Slghoadoe By Do is s By P oe el lges) i
characters to the start of the file name. '“’“ [ Rpeia Cor 4

W Export Image Shooting Properties T
You can select specific items from the shooting information and e e stk e el
export it to a text file. PR - 3 Eapen e TengErpaees :

M Export Images as a Screen Saver | dndeaab O Enpurt ke s B S
You can export an image as a screen saver file. 4 v s mana ot P e W

O Ewpen B boagi 55 VWeakgap

M Export an Image as Wallpaper oy A

You can export an image as a wallpaper file. This function will o e v PO L

not work with multiple files selected.

M Copy Images and Rename

You can copy the selected image and save it. At this point, you
can also add identifying characters to the start of the file name.

& o i [ ]

80 ZoomBrowser EX Software User Guide




Chapter 6

Using Supplementary Features EXpO I’ti ng | m a g ES ( 2/ 2 )

K. Setting the Export Settings 6, Click [Finish].

The contents of the export settings vary according to the This will export the image(s).
selected export format. Adjust the settings according to the

displayed information. Be sure, however, to note the file name REFERENCE ,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,
of the exported file. Rename] options and save in the JPEG file format, the shooting

information is saved along with the image.
n _m";rm'f LR C Hvnid i, gl T Slyroador by D s sm By Sotsies | ifesi s XL
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Destination folder
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Chapter 6
Using Supplementary Features

Running a Slide Show (1/2)

This section explains how to run a slide show displaying images in
sequence in the full-screen mode.

Setting and Starting a Slide Show

1.
2.
3.

Click [View & Modify] in the main window.
Click [View as a Slide Show] in the next menu.

In the Browsing Area, select images and click [Next].

You can select multiple images or a folder and have the images
in the folder included.
The images will display in the order they are selected here.

Select the Image Size option to
be used when displaying the
images.

Selects the display methods for
image information, such as the
file name and titles, and the
control panel (explained on
the next page).

Select [On clicking the left mouse button] to have the slides
proceed manually, not automatically.

Select [Every X seconds] to have the slides advance
automatically and set an interval in seconds with the slider.
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4.

B Feemitie :
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Set the display settings for the slide show and click

[Finish].

Specify whether to stop the slide
show (upper button) or continue
running it (lower button) when

it comes to the end.

Select the transition effect to be used
when moving from one slide to another
(When you click an effect, you can get a
preview of how the effect looks)

If you want the transition effects to be
randomly assigned, select [?].
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Sls‘i:lr;t::::plementary Features RU n n i ng a Sl ide ShOW ( 2 / 2 )

The slide show starts. While running a slide show, you can use the control buttons at
the bottom right of the window to control the show.

Click this button to return  Click this button to move
to the previous image. to the next image.

EAEIE IR

Click here to pause the show
(Click again to resume play)

Click here to end
the slide show

Click this button if you see an image you would like to

print during a slide show. (The color of the button will

change to orange.)

When the slide show finishes, PhotoRecord (printing

e JENE utility) will automatically start and the selected image will
| appear in the printing window.

The file name and control panel will display if the If you click this button while an image is displayed, the image will
[Show information] option was selected in the appear in the selected state in the Browsing Area after the slide show.

[Image Information] section shown in the settings
on the previous page.

Click here to add the Favorites symbol to images. It is
used to facilitate image searches.

REFERENCE

® You can also start a slide show by clicking the [View] menu and
selecting [View as a Slide Show].
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Chapter 6

Using Supplementary Features Adding SOUﬂdS tO |mages

You can add sounds to your images and play them later as necessary.
REFERENCE

e To use a sound file with images, it must be of one of the follow-
ing formats:
WAVE (with WAV extension)
MIDI (with MID or MIDI extension)

How to add a sound to an image

In the Browsing Area, select an image, click the [Edit] menu and
select [Add/Remove Sound].
The following dialog box appears.

Suund

Cimanhy Samelad Sourd Fla

_ |
- al

[

Click [Add]. In the file dialog box, select a sound file and click
[Open]. Next, click [OK] to add the sound to the image that you
selected.
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The following mark appears when an image is accompanied by
a sound.

This mark indicates an
image with a sound.

[ PR LECH S W (P P

REFERENCE

* To remove a sound from an image, select the image, click the
[Edit] menu and select [Add/Remove Sound], then click [Remove].

* When you add a sound to an image, the sound file is copied to
the same folder as the image.

How to play a sound added to an image

Select an image with a sound attachment, click the [Edit] menu
and select [Play Sound].

ZF May Sound




Chapter 6
Using Supplementary Features

Checking and Changing Camera Settings

You can check camera settings from the computer.
IMPORTANT

e Ensure that the camera and computer are connected with an
interface cable and are ready to communicate before you
perform this procedure.

REFERENCE

e You can also adjust the camera settings by clicking Ll (Set) in
the Camera Window and selecting [Camera Settings] in the next
menu.

Checking and Changing Camera Settings

Click the [Camera] menu in the main window and
select [Camera Settings].

SV tesmllipaset |0 Cothanimarm gaal Boriiaga Syboase Uy D e By ©ise] l‘l‘iuj
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This will display a window like the following. You can check or
change each setting in this window.

Type the name of the owner of the camera here.

Use this button to synchronize the
camera clock and your PC clock.

Camsi i Motidl  Canon 3005000000000
FrmesaeMeenon. 1000
Il ﬂli'ul'l:ﬂnl-
ahe md (e . ]
[ B 7 15 Jo ™ m P fampr | Click this button to
|| - synchronize the camera’s
Daomp 12t p— date and time settings
with the computer.
M Fome 1 Click this button to
format the camera’s
Slghe Inssled memory card (not
[ Free 42 ME supported by some
Toeal 1523 MB camera models).
|' il | Cacel | Apgly

After you have checked the camera settings and made
necessary changes, click [OK].




Chapter 6
Using Supplementary Features

Saving the “My Camera Settings” to the Camera (1/7)

This section explains how to save the “My Camera Settings” on your
computer to the camera or vice versa.

What are the My Camera Settings?

The start-up image for the camera and sounds such as the
start-up sound, the shutter sound, operating sounds and the
self-timer sound are collectively referred to as the My Camera
Settings. You can add your favorite images and sounds from
your computer to the My Camera Settings in the camera.

Displaying the My Camera Settings

86

ZoomBrowser EX comes with some My Camera Settings already
prepared. Start by displaying this data.

IMPORTANT

e Ensure that the camera and computer are connected with an
interface cable and are ready to communicate before you
perform this procedure.

Click the [Camera] menu in the main window and
select [My Camera Settings].
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The My Camera window displays.

Switches between theme Changes the type
sets and individual settings. of data.
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My Camera Settings that are My Camera Settings
already on your computer display in your camera
here. display here.

Try switching between the [Setup as a theme] and [Set Individually]
tabs, and in the [Set Individually] tab, try changing options in the
Data Type category. The My Computer list displays the image files
and sounds that were previously prepared. The Camera list displays
the My Camera Settings currently in the camera (only the editable
settings are shown).




Chapter 6

using supplementary reatures 9aVING the “My Camera Settings” to the Camera (2/7)

You can save the files that appear in this list as My Camera Saving the My Camera settings to the camera

Settings to your camera. _ , , _
This topic explains how to save the previously recorded My

REFERENCE Camera Settings files to the camera.

* Theme settings are a collection of My Camera Settings with 1. Select the [Setup as a theme] tab in the My Camera window.

To set the My Camera Settings individually, click the [Set
Individually] tab instead and select the respective settings, such
as the start-up sound or image, in the Data Type category.

something in common.

® You can change all of the My Camera Settings—the start-up
sound, the start-up image, the shutter sound, the operating
sounds, and the self-timer sound—on the camera in one easy

step by selecting the [Setup as a theme] tab and saving the Select the [Setup as a theme] tab.
desired theme set to the camera. My Camern
* You can also add new files as My Camera Settings to the i
. . . . . . Sabup a5 2iere |k e prdedualy
Computer list (the procedure is explained later in this section). T
* Pre-prepared My Camera Settings can be found on the disk on e e
which ZoomBrowser EX was installed. Open the following . Camens
sequence of folders: [Program Files], [Canon], [ZoomBrowser EX], | T 8 EER
[CameraWindow] and [MyCameraFiles]. b i
* You can also open the My Camera window by clicking the [Edit] e g
menu and selecting [My Camera Settings]. e |
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Chapter 6
Using Supplementary Features

Saving the “My Camera Settings” to the Camera (3/7)

2.

88

In the My Computer list, select a setting you would
like to add to the camera.

When you select [Setup as a theme]:
The start-up image will preview in the area to the right and the

start-up sound, the shutter sound, the operation sound and the

self-timer sound will play in order.

When you select [Set individually]:

When you select a start-up image, it will be displayed in the
preview area to the right. When you select a sound file, it will
automatically be played.
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3.

Select the settings file you would like to replace in the
Camera list and click [Save to Camera].

Click [OK] if a confirmation dialog appears. The settings file in
the camera will now be replaced with the one you specified
from the computer.

REFERENCE

* Please note that the original settings file in the camera is
overwritten and permanently erased. To restore the original
settings file, you must add it once more to the camera. Before
you overwrite a settings file in the camera, confirm that it
appears in the My Computer list.

© Select the setting you want to replace.
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@ Click this.

Repeat Steps 1-3 to replace all the settings files with those you
wish to save to the camera.




Chapter 6
Using Supplementary Features

Saving the “My Camera Settings” to the Camera (4/7)

4,

89

Click the [Close] button to close the dialog.
This concludes the procedure for adding settings to the camera.

Next, you will have to change the settings on the camera itself to
use the new start-up image and sounds. See the guide supplied
with your camera for instructions for changing the settings.

IMPORTANT

e Never detach the interface cable, turn off the camera power, or
do anything to stop communication between the camera and
computer while the My Camera Settings are being saved to the
camera.

REFERENCE

e To delete settings files in the Camera list, select the file and click
the [Delete] button.
* You can check a sound file in the camera by clicking [Play].

Coammn

—— Click here to delete a file from the list.

Click here to check a sound file in the
camera.

—— Displays the camera settings when
an image file is selected.

ZoomBrowser EX Software User Guide

Adding New Files to the My Camera Settings

Create a new image or sound file and save it to the computer
and then add that file as a My Camera Settings file.




Chapter 6

using supplementaryreatures9aVING the “My Camera Settings” to the Camera (5/7)

Create the new files before adding them

Start by creating the image file or sound file that will be used as
a My Camera Settings file and save it to the computer.

M Creating a Start-Up Image File

Create an image file using an image editing program.
The file should be in the JPEG format, 320 x 240 pixels, and less

than 20KB.
REFERENCE

e See the manual and help facility for the editing program for a
detailed explanation of how to use it.

M Creating a Sound File

Use the functions of the My Camera Sound Maker to record
and edit sounds. The My Camera Sound Maker functions are

explained on the next page.
REFERENCE

¢ Record the sound as an 11.025 kHz or 8.000 kHz, 8 Bit, Mono
sound in the WAV format. Sound files that can be added to the

camera should conform to these guidelines.

Duration in Seconds
Type
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Operating Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
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Adding the new file as My Camera Settings to the
computer

Once you have created the settings file and saved it to the
computer, use the following procedures to add it to the My
Camera window.

Click the [Set Individually] tab in the My Camera window
and switch the Data Type.

Click the [Set Individually] tab in the My
Camera window and switch the Data Type.
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Click [Add File].
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using supplementaryreatures 9aVING the “My Camera Settings” to the Camera (6/7)

3_ In the Open dialog, select the file you created and
click [Open].
The selected file will appear in the Computer list.
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This concludes the process for adding the new settings.

You can save the newly created settings to the camera using
the procedures described in the Saving the My Camera Settings
to the Camera section.

REFERENCE

..........................................

e To delete a settings file, select it and click the [Delete] button
beneath the My Computer list.

* Previously created settings can also be added as My Camera
Settings to the computer with the same procedures as above,
but have to comply with the specifications listed in the Create
the new files before adding them section.

91 ZoomBrowser EX Software User Guide




Chapter 6
Using Supplementary Features

Saving the “My Camera Settings” to the Camera (7/7)

Saving the Settings to the Computer

1.

92

You can copy the My Camera Settings from the camera to the
computer.

Click the [Setup as a theme] tab in the My Camera
window.

To set the My Camera Settings individually, click the [Set
Individually] tab instead and select the respective settings, such
as the start-up sound or image, in the Data Type category.

Select the setting you would like to copy from the
Camera list.

If you selected the Theme tab in Step 1, the preview image will
display in the area to the right and the start-up sound, the
shutter sound, the operation sound and the self-timer sound
will play in order.

If you selected the Set Individually tab and the start-up image in
the Data Type category in Step 1, the start-up image will display
in the area to the right. If you selected a sound, it will
automatically play.

My Camera
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3.

4.

Click [Save to PC].

My Camara
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Assign a name to the settings file and click [OK].
The settings file will copy to the computer disk. If there is a
settings file with the same name, it will be over-written.

Repeat steps 1-4 as required to save the settings files you wish
to copy to the computer.

Click [Close] to close the My Camera window.
This completes the copying process.

IMPORTANT

* Never detach the interface cable, turn off the camera power, or
do anything to stop communication between the camera and
computer while the settings files are being copied.
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Creating a My Camera Sound Recording and Editing Sounds

The following section introduces the [My Camera Sound Maker]

) . ) — Use these tabs to switch between sound files for recording and editing.
function, which allows you to record and edit the start-up

sound, shutter sound, operation sound and self-timer sound. Click here torecord sounds. Ends the recording.
Click here to open sound files. Displays the Help menu.

Click the [Camera] menu in the main window and Change the file format.

select [Create a My Camera Sound]. Cuts out unnecessary sound portions.

1 Devmltirames (3 € fhnsmasm ganl Sortiga Slytas iy s e By Fiuisie LIS B

He bl yees Qs BT
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Erorichrile T S
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The My Camera Sound Maker window will open.
IMPORTANT

e The My Camera Sound Maker window will not appear if
QuickTime is not installed.

REFERENCE S S T e

| e i et e e e
..........................................

e For detailed information on how to use this function, please |
refer to the Help file (open it with the [?] button).

EIEAE

Sets the blue and Plays sounds.
red switches.
[ The blue and red switches designate the sound
Volume ;
range. (You can delete useless sections by
—— Shows from where the clicking the [Cut] button after having selected
sound starts to play. the desired sound portion with the switches)
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IMPORTANT Saving a Sound
e The “Sound time” will display in red if the sound file exceeds Click here to save a sound (A window allowing you to name the file will display).
the time limit. T
If this happens, select the desired sound portion using the blue i £ -
and red switches and select [Cuts both switches, before blue | E' L
and after red] from the [cut] menu to delete unnecessary sound - gl
portions. el
In addition, when you select [Limits blue and red switch within T T W S o
limit time], the switches can no longer be moved outside of the "
time limit width.

REFERENCE

......... Mud ﬂhr'

e The Volume switch setting affects the volume of the sound file
to be saved. In other words, if you turn down the volume of a
sound you recorded on the computer because it is too loud - Ry
when you play it, the sound will have a low volume when you
upload it to the camera. So when the playback volume is too
loud on the computer, turn down the volume of the speakers. 1A S e -

'EF.-_ 1. Toxm g Gamasi CipmEil

].#l.lrr."’nm

Select the sound to be saved.

REFERENCE

e Each sound file is automatically given an extension according to
the type of sound.

e The actual file name is composed of the name of your choice in
the first part, followed by characters specifying the sound type
(_OPO1 or _SSO1) and the extension (.WAV) in the latter part.

e \When a number of different types of sounds are saved at the
same time, the first part of their file name will be the same.
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Playing Movies

ZoomBrowser EX supports movies.

95

When you connect a camera with movie files on it to the
computer and open the Camera Window, a thumbnail of the
first image of each movie file will display with a movie camera
symbol on it.

You can import movie files in the Browsing Area the same way
you do images. In this case, a thumbnail and a movie mark
appear in the Browsing Area. When you double-click the
thumbnail, QuickTime Player starts and plays the movie.

ZoomBrowser EX Software User Guide

The thumbnail and mark appear
when a movie is imported using
the Camera Window.
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Use this button to
play the movie.




S:i:lzt::l:plementary Features Editing MOViES (1/ 4)

You can create movies by adding various effects: linking movies and still
images that have been downloaded to a computer, superimposing titles
and other text, and adding background music.

REFERENCE

¢ Movies are saved as AVI files in the Motion JPEG format.

Procedures for Editing Movies

9. Cdlick [View & Modify] in the main window, followed
by [Edit Movie].

2_ Select a file (movie or still image) to edit in the
Browser Area and click [Next].

You can select multiple movies or still images.

3_ Follow the steps at the window'’s left. Once you have
finished editing the movie, save it and close the
window.

The features and procedures for each step are explained on the
following pages.
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Follow these steps
to proceed

e kX — allii B

Guidance Click this button for detailed help
with operating procedures
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Storyboard Area
Displays thumbnails of the selected images.
Links images in order from left to right

Click here to proceed to the
next step or previous one
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Editing Movies (2/4)

Features of the Storyboard Area

Changes the order of the
selected images

cictis buron to iy — KN {7 [ | Gl 2]
Clthsbutton toply fo | = =) |
(] |

Displays the properties of the
selected image

Transition Box

Displays the icon of the transition —
effect used to link adjacent images
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— Displays a dialog with the general
movie editing settings

Deletes the selected image from
the storyboard area
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Editing Movies (3/4)

Features of the Arrange Window

Moves the image selected in the storyboard
position to the left or right

n .MIH LR i i il Bl i 0 0 [ il By P s i
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You can set the playback range (start and stop points) of a

movie selected in the storyboard area by clicking this button

You can set the play duration of a still image selected in the

storyboard area by clicking this button
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Features of the Apply Effect Window

Superimposes titles and other text on the image
selected in the storyboard area

You can set the font, display duration, display
position and scrolling attributes of the text

film simulation
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You can change the image selected in
the storyboard area into a sepia or
monochrome image, or add noise for a
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You can set the transition effect between
images by selecting the transition effect box in
the storyboard area and clicking this button
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Editing Movies (4/4)

Features of the Set Audio Window

You can link MP3-format and WAV-format audio files as
background music or sound effects

When you link a sound file using this procedure, a bar appears
under the thumbnail in the storyboard area indicating the
duration of the audio file
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You can adjust the volume or set the fade-in or fade-out
effect for a movie or its linked audio file by selecting it in the
storyboard area and clicking this button
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Features of the Save Window

Specifies the file name

Selects the destination folder
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You can set the size (height and width in pixels) and ‘

frame rate (frames/second) of the movie being Saves the file
saved by selecting [Motion JPEG (AVI)] and clicking
the [Advanced Settings] button at the right
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Exporting Movies (1/2)

This feature changes a movie to another file format or size and exports it.

Procedures for Exporting Movies

1_ Click [View & Modify] in the main window, followed
by [Export Movies].

2_ Select a movie in the Browser Area and click [Next].
You can select multiple movies.

3_ Follow the steps at the window’s left-hand side to
proceed. Finish by exporting (saving) the movie.

The features and procedures for each step are explained on the
following pages.
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Features of the Select the Save Format Window

Select between [Motion JPEG (AVI)] and [QuickTime movie (mov)] as
the format in which to save the movie file
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To save the movie in a rotated orientation, click here to add a check
mark and specify a rotation direction.

Use this feature when a camera has been turned on its end to shoot
a movie sequence
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Exporting Movies (2/2)

Features of the Set the Save Format Window

To change the size of the movie being exported, select [Zoom
specification] or [Size specification] and set the size
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Selects the number of frames
displayed each second

Sets the image quality. The
higher the setting, the clearer the
image, but the file size also
increases correspondingly
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Features of the Specify Name of File to be Saved Window

To save the movie under its original file name, select [Same as
original image]

To assign sequential numbers in a multiple movie selection, select
[Assign Sequence No.] and specify a root name to precede the

numbers
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S:i:lzt:lr::plementary Features Converting RAW Images (1/ 5)

If your camera supports RAW images you can handle higher quality

images Converting RAW Images

However, the RAW format is a special file format and RAW images _ _

cannot be opened or processed in their native format in standard image 1, Select a RAW image in the Browser Area.

processing programs. RAW images must first be converted to standard _ _ o o

file formats, such as TIFF or JPEG formats. This section explains 2. Click [View & Modify] in the main window, followed

conversion procedures. by [Process RAW Images] in the next menu.
IMPORTANT

e Refer to the manual supplied with your camera to determine
whether your camera supports RAW images or not.

* Depending upon your camera model, a different program than
the one introduced here may start when you convert RAW
images. If that occurs, refer to the manual for the software
supplied with your camera.

REFERENCE

..........................................

* RAW images are extremely high-quality images that are not
subject to any deterioration due to compression processing.

e See the Help menu for conversion details. After you click
[Process RAW Images], click the [Help] menu in the main
window.
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As shown on the next page, the main window, Navigator
window, and Image Quality Adjustment Window will display.

REFERENCE

e |f the Navigator window does not appear, click the [View] menu
and select [Show Navigator].




Sls‘i:nr;t::::plementary Features COnverting RAW |mageS (2/ 5)

¥ Main Window ¥ Image Quality Adjustment Window
The conversion is conducted in this window. You can adjust the brightness, contrast and coloration of a
RAW image as it is converted. See the Features of the Image
You can use this Quality Adjustment Window for details.
button to switch
bet i
) aﬁd‘/\é?se;alymrangoe;es Iireage Duality fd just. .. .__ : rE_]
Thumbnail and set various CAMErE. KRN
conversion settings, Ganeral Adustments | Tone cy 4] # |
Check Mark such as the image et s S |
rotation P +] i |
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Preview [A000-10000
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(100-+1 000
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preview image that is SRS | .
zoomed in the main window - w10l
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and dragging it (505
W i i
Reget |
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Converting RAW Images (3/5)

3.

Adjust the image quality as required in the Image
Quality Adjustment Window.

Click the [2. Save] tab in the main window, set the file

format and save destination, and then click [Save].

-
i miags

Selects images that will be saved

with the same settings (All el . | ETT
images, or images marked with a | o Tou
check in the main window) A Frag
Selects the image file format ——  Conitnn P W P
crapmvems Reda | 0 5 _I

Pl

Sets the destination folder
for the image file
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5_ Click the [3. Exit] tab and click [OK].
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Converting RAW Images (4/5)

Features of the Image Quality Adjustment Window

The adjustable categories may vary according to your camera

model.

Image Quality Adjust... Eﬂi\@
Camera: RS EEE

General Adjustments ‘Tnne [ ‘In

\White Balance

Auto j ﬁ
Colaor temperature
El 4

(2000-10000)

Magenta Green I___
—e 0

(-100-+1 00

Adjusts the white balance
by the light source or
color temperature, etc.

ﬁntn Effect

for =

Adjusts the digital
exposure compensation, Contrast
photo effect, contrast, ey ] 0
sharpness and saturation Sharpness {-5-+5)
— 7
Saturation {010
— |—n
, {-5-+5)
With a check mark here, '~ Frov
settings changes in this fEVIEN
window are immediately Reset | +—

reflected in the image

Restores all adjustments to the initial shooting settings

105 ZoomBrowser EX Software User Guide

Scrolling Tab Titles
Click the arrows to display the other tab titles. Click a
tab title to change tabs and access the other settings

image Quality Adjust... [& | (%)

Carmars e e
Tiofed Ciswa | Advancad Adiustn € | b
Wnils Balance ‘
Tia] :_,‘ _ﬁ;’I

Cplor temoeratura

Tone Curve Tab

You can adjust the RGB
channel settings
together or individually

Advanced Adjustments Tab
You can set the settings for
noise reduction processing,
fading correction and the
output color space

Selects preset color schemes or
My Color custom color schemes
(see next page for explanation)

Applies the settings to the
displayed image
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Converting RAW Images (5/5)

Registering Custom Color Schemes (My Color)

106

If you register a custom color scheme as a “My Color” scheme,
you can apply this scheme easily to additional images when you
convert RAW images.

IMPORTANT

e To register a “My Color” scheme, two images are required: the
pre-adjustment image and the post-adjustment image. Use
ZoomBrowser EX's image editing functions to prepare the two
images before proceeding. Save the two images in the BMP, TIFF
or JPEG format.

Click the [Edit] menu and select [My Color].

Select [Create and Add My Color] from the next
menu, followed by [Next].

Click [Read] beside the
original image, select the pre-
adjustment image (original
image) and click [Next].

ZoomBrowser EX Software User Guide

4.

Click [Read] beside the target image, select the post-
adjustment image (target image) that you have modi-
fied with an image editing program, and click [Cre-
atel].

The program will calculate the differences between the original
and target images, apply those corrections to the original image

and display the results as the Preview My Color Applied to the
Image.

Dot 7 a5 Pieeema by Dids Applesd o s e
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Check the Preview My Color Applied to the Image and
click [Next].

Type a name or comment and click [Finish].

REFERENCE

* You can apply the registered My Color scheme to additional
RAW images when you convert them by selecting it from the
Photo Effect menu in the Image Quality Adjustment Window.
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Operating the Camera Shutter from the Computer (1/4)

This section explains the procedures for remote shooting, the process of
operating the camera shutter remotely from a connected computer.

107

IMPORTANT

* To confirm whether your camera supports remote shooting or
not, check the guides that accompanied the camera.

e Ensure that the camera and computer are connected with an
interface cable and that the camera is ready to transfer data
before attempting remote shooting. If the camera is equipped
with a lens cover, ensure that it is open.

e Ensure that you turn off your computer’s standby feature before
you begin remote shooting. The results cannot be guaranteed if
the computer enters the standby mode while remote shooting.

e Except for the shutter button, the camera’s buttons and
switches, including the zoom, cannot be manually operated
while the camera is being remotely controlled.

e The time lag between pushing the shutter button and the
release of the shutter is slightly longer for remote shooting
compared with the normal mode of operation.

* Depending upon your camera model, a program different from
the one shown here may start up. Please refer to the manual for
the software supplied with your camera if this occurs.

REFERENCE

* See the Help menu (it can be opened from the [Help] menu in
the remote shooting window) for detailed operating procedures
for remote shooting.

* Images captured while remote shooting are saved into the folder
that was selected when [Remote Shooting] was clicked.

ZoomBrowser EX Software User Guide

Remote Shooting Procedures

Check to make sure that the camera is attached to the
computer and ready to transfer data, then click [Camera &
Memory Card] in the main window, followed by [Remote
Shooting] in the next menu.

i T Y E i
:
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A remote shooting window like that below will open.
Clicking the [Release] button in this window records the image.
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The image captured by the
camera displays here

This button turns the
display on or off
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Features of the RemoteCapture Task Window

Selects the image's recording size and compression

Sets the rotation setting of the image being recorded.

- : This setting cannot be adjusted if your camera’s Auto Rotate
i RomotaCapturn Tak - function is set to On.

FiaiF) CaEresl] Foobting sl Sl

Switches between showing and hiding
the viewfinder and the detailed (2] e ViewFirdes G
settings sections. () oo snootng dotads &

rmeER
v B

' E_] —— Releases the camera shutter
(you can also release it by pressing the camera’s shutter button
or the space bar on the keyboard)

You can add a comment to an image [ Al coetasris Shind Dbl
by clicking to place a check mark |
here and inputting text in the box
below.

Viewfinder

Sets the camera’s zoom

Turns the viewfinder display on or off

Refreshes the exposure, focus and white balance settings
(these settings remain fixed until this button is clicked)

Sets the shooting settings. It is divided into the “Field angle/
flash” tab and the “Shooting settings” tab.
(The settings categories vary according to your camera model)

|F.." |nl:i.'.:
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Operating the Camera Shutter from the Computer (3/4)

Other Remote Shooting Features

¥ Interval Timer Shooting

Interval timer shooting is the method of capturing images in
which a set number of frames is recorded at set intervals of time.
[ ey — Click the [Shooting] menu in the
RemoteCapture Task window and select
. i [ [Interval Timer Shooting] to open a
confirmation dialog. Click [OK] to open
a window like the one shown here. Set
T the values and click [Start] to start
shooting. The interval may be set to a
range from 5 seconds to 60 minutes.

------------------------------------------

* You may not be able to record at the set interval if it is too short
for the camera to transfer and save the image data.

M Timer Shooting

Timer shooting is the method by which a single image is
recorded after a set number of seconds.

Click the [Shooting] menu in the
RemoteCapture Task window and select

——— s [Timer Shooting] to open a window like
the one shown here. Set the number of
I seconds for the delay and click [Start]. The

timer may be set to a range from 2
seconds to 30 seconds.
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Saving and Recalling Shooting Settings

You can save the current zoom settings and the settings in the
“Field angle/flash” and “Shooting settings” tabs by clicking the
[File] menu in the RemoteCapture Task window and selecting
[Save Shooting Settings].

Later when you wish to recall those settings, click the [File]
menu in the RemoteCapture Task window and select [Batch
Shooting Settings].

i Displaying the Subject in the Camera’s LCD Monitor

You can use the camera’s LCD monitor or a television
connected to the camera to view the subject while shooting
remotely.
TR Click the [Camera] menu in the
o oo | RemoteCapture Task window and select
- ~ | [Camera Display Settings] to open a window
e like the one shown here.

Select [Camera LCD monitor] or [Video Out
i S terminal] and click [OK].

e See the Camera User Guide for instructions for connecting the
camera to the television.




Chapter 6
Using Supplementary Features

Operating the Camera Shutter from the Computer (4/4)

Remote Shooting Default Settings

You can display the default settings for remote shooting by
clicking the [File] menu in the RemoteCapture Task window and
selecting [Preferences].

M File Settings Tab
|

Fia Salirge | Gipoors |
e Wingrn iy

Ll
gy i Bl e e

Sets whether images are saved only to
the computer, or also to the camera’s
Fir Sslm i i€ chasdm| memory card

.i'q:lli"'

For example, if you type "Capture,” file
names are automatically assigned in
ascending order starting from

# “Capture_00001.jpg”.

i ] You can also change the number of
assigned digits and the starting number

dirpegn Sevjuienos W
P o Cagy T

[ g mu [
I Divmimss e Setnage’ ¥ i by Doptmrery by |

| K | Ll

I
Folder to which recorded images are saved
(folder selected at the point when remote shooting was started)

REFERENCE

e |f you click [Save Images On] and select [Computer only], you
can record images when the memory card in the camera is full
and will not accept more images or when it is not present.
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Sets the root file name for saved images.

Options Tab
ia Lafegn  Lmors
Reliie Haolots
(I — -
o i [Tl
= Alpa On Tan
._T..::I Carmid

You can release the shutter using the
key specified here

Click to place a check mark here to
have the RemoteCapture Task
window remain in front at all times




Chapter 6

using supplementaryreatures  91ITCNING Panoramic Images - PhotoStitch

If you have several images of the same scene with only slight differences,
you can use PhotoStitch to connect the images together to make a
panoramic image. This section explains how to use this program to stitch
images.

REFERENCE

¢ For detailed information on how to use PhotoStitch, refer to
PhotoStitch Help (accessible from the [Help] menu).

* You can make it easier to stitch images together by using the
camera’s Stitch Assist mode to shoot them.

Opening PhotoStitch

Click [View & modify] in the main window, followed by [Stitch
Photos] in the next menu.

-El-ﬂ
-Eﬂdﬂ' gl ’l

p-__.

In the Browsing Area, select the images you would like to
merge and click [Finish].

REFERENCE

* You can also start PhotoStitch by clicking an image with the
Stitch Assist mode mark (a line with arrows) in the Camera
Window.
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Then, follow the instructions on the upper part of the
PhotoStitch window, and stitch your images together.

Decide the order
in which the
images should be
stitched.

v

Perform stitching.

v

M—— Save the image.

REFERENCE

* You can also start PhotoStitch by clicking the [Tools] menu and
selecting [Stitch Photos].




Chapter 6
Using Supplementary Features

Saving Images to CD-RRW Disks (Windows XP Only)

Saving Images to CD-R/RW Disks

112

You can copy or save images onto CD-R disks and CD-RW
disks. The shooting information is saved along with the image.

IMPORTANT

e This feature is only possible with computers satisfying the fol-
lowing conditions.
- Windows XP is pre-installed
- A CD-R/RW drive is built-in

REFERENCE

e You can add additional images to a CD-R/RW disk that has been
written to previously.

Place a CD-R/RW disk in the drive.

If a window like the one shown here appears, click
[Cancel] and close the window.
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Click [View & Modify] in the ZoomBrowser EX main
window and [Backup to CD] in the next menu.

In the Browsing Area, select the images or folders you
wish to save and click [Next].

Select the destination CD-R/RW drive, input a title for
the CD and click [Finish].

il

Fmcm e B By ey B -

Destination drive
CD Title
Speed

Available space on the CD-R/RW disk

This will copy the images to the CD-R/RW disk.
The disk will be ejected from the drive when copying is complete.




e Supported File Formats

The following is a list of file formats supported by ZoomBrowser EX.

Readable files

ZoomBrowser EX can read the following file formats.

M JPEG files (.JPG)

Most cameras use this file format. It compresses at very high
ratios, taking advantage of the characteristics of the human
eye. However, because it is an irreversible compression method
(part of the data is lost during compression), if you process and
save an image repeatedly using this method, the image may
become rougher.

M RAW files (.CRW)

This format is a proprietary file format provided by Canon. It
saves the output of the image pixels from a digital camera
without any deterioration in the quality of the image. Some
cameras might not support this file format.

B Windows bitmap files (.BMP)

This format comes standard with Windows. Most \Windows
programs support it.

M TIFF files (.TIF)

This is a relatively popular format. It is widely supported by non-
Windows programs (such as Macintosh).
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PhotoCD files (.PCD)
This is the format used by Photo CDs.

Video clip files (.AVI)

This is the standard Windows video file format. The
ZoomBrowser EX Browsing Area will display a thumbnail image
and the video camera symbol.

When you click the thumbnail or movie icon, QuickTime Player
starts and plays the video clip. (You must install QuickTime
Player before you can use it.)

QuickTime files (.MOV)

This is a movie file format. The file appears as a movie mark in
the Browsing Area of ZoomBrowser EX. When you click the
movie mark, QuickTime Player starts and plays the movie. (You
must install QuickTime Player before you can use it.)




Appendices

Auto-Download Settings (1/3)

You can set which downloading method is used after ZoomBrowser EX
starts automatically when the camera is connected to the computer.
You can also use this setting to specify the downloading process when
the camera is connected to the computer after ZoomBrowser EX is
already running, or when you click the [Camera & Memory Card] task
button and select [Browse & Download Images].

1.

114

Click the [Camera] menu and select [Auto-download
setting].
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The Auto-Download Settings window will open.
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2.

Select the action executed when the camera is con-
nected and click [Next] or [Finish].
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If you select this option, the Camera Window will
automatically open when the camera is connected.
After choosing this option, click the [Finish] button
to close the settings window.

If you select this option, the images in the camera will automatically download
to the computer when the camera is connected.
However, if you place a check mark beside the
[Display confirm message before downloading] b
option, the window at the right will display,
allowing you to select an action. ] g
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T Auto-Download Settings (2/3)

3_ Select the type of images to download and click 4_ Select the image destination and click [Next].
[Next].
Specifies the folder to Select this option to have the images saved
e el A i Rt by i iy P " which images are saved into new folders created within the folder
(TP g ey specified in the category above. Select from
=i the options below for the naming
PR I conventions for the new folders.
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If you click either of these two options, only the images
selected with the camera functions will download.

Type a folder name here if you
select the [Set as new] option.

If there is no check mark in this option, the file name for the image is kept the
same as the file name in the camera (the file name assigned by the camera
when the image is recorded). For example, the name might be
"IMG_XXXX.JPG." If you place a check mark in this option and type a root
name, the image file name becomes “root + XXXX.JPG,"” where root is the
word you type and the “Xs" represent numbers.
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T Auto-Download Settings (3/3)

K. Choose the action to be executed after images are
downloaded and click [Finish].

After downloading, display the
folder containing the images
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After downloading, you can have it continue to process images.
- Layout Print

- Contact Sheet Print

- View as slideshow

- Send by e-mail
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T Customizing Preferences (1/3)

ZoomBrowser EX provides a variety of preference settings that you can General Tab

customize to make the program work the way you like. This section

introduces some of the major preference settings you can change. Sets the thumbnail settings for the Browsing Area and the
REFERENCE zoom options.
.......................................... E—— i

e ZoomBrowser EX offers a wide variety of preference settings that
you can customize. Therefore, before you modify an option, wal | |image iy | Setecion | Fuly
access Help from the [Help] menu or the [?] (Help) button to see P
a description of the option. Musem visbie thombrsd sice i

Mrsewm cick apls Fursbrad s ]

Opening the Preferences dialog box _
R i bl

Click the [Tools] menu and select [Preferences] to open the
Preferences dialog. To change a setting, click the appropriate Zoomey
tab in this window. | e

Seiaws Mywmadie By lisi ialealy B i .H-. {
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Fat

— Sets the thumbnail
settings for the Browsing
Area.

— This group box controls
the way the zoom
operations react in the
Browsing Area (Moving

the slider to the right
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increases the image
display speed).




Appendices

Customizing Preferences (2/3)

Image Editor tab

This tab selects the application program when a program other
than ZoomBrowser EX is used to edit images.
Frofurnnces

|mznges E citirg Program
Edit mages umng fre delall =dion bl

| Selects the program to

: start when you click the

0 Images: usng e pEGren helow [View & Modify] menu in
[ the main window and

select [Edit Image].

7
e

REFERENCE

------------------------------------------

e “Edit images using the default editor below"” has a list contain-
ing an image editing program that is detected automatically. If
you want to use a specific program other than the default, click
“Edit images using the program below” and use the [Browse]
button to locate the program.
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Selection Tab

This tab sets the image selection methods and the image
selection steps used with the task buttons.

{_E PFrofwrnuces
]
Seiechon | s . .
— | Sets the image selection
Toage iskechon me.thod
M Wirdows slandad slection
Taat S=laghon

N Fubovigre oakieCl ivca(pes e & lad

Remove this check mark to streamline the image
selection steps when a task button is used.

REFERENCE

e With [Windows standard selection], the first image is deselected
when a second image is clicked. Multiple selections can be
made by holding down the [Ctrl] and [Shift] keys while clicking
on successive images.




T Customizing Preferences (3/3)

Rotate Tab

This tab sets the rotation settings.

Frofurnnces

P okasdenes T e
= Potshe oignal JPED image Place a check mark here
Fizlgte 5 copg ol e JPEG mage to have the original

image rotated as well
when a JPEG image is
rotated in the Browsing
Area.

Only the rotated image
is sent to the Browsing
Area when you
download an image that
- —— has been rotated in the

' i — LR Camera Window.

Place a check here to have the original image left
untouched and the rotation applied to a copy
when a JPEG image is rotated.

Both the original image and the rotated image
are sent when an image rotated in the Camera
Window is downloaded to the Browsing Area.
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Appendices CUStOmiZing MenUS

Click the [Tool] menu and select [Customize] to open a window
like the one shown below.
Use this window to set the categories to display and click [OK].

Sets whether options are shown or hidden on the menus opened by
clicking task buttons in the main window.
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I
Remove the check mark from the menu items you wish to hide.

Sets the categories displayed in this menu.

REFERENCE

..........................................

e Use this function to hide items not used on a daily basis to
streamline the menus or to shorten the menus so that scrolling

is not required.
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e Setting up Slide Shows on the Camera

If the camera comes with a slide show feature, you can use From the image list on the left, drag images to the right area
ZoomBrowser EX to edit slide shows. and arrange their sequence for the slide show.

IMPORTANT

e Ensure that the camera and computer are connected with an
interface cable and that the camera is ready to transfer data
before you perform this procedure.

REFERENCE

* See the guide for your camera for information on using and
playing slide shows.

e You can also set slide show settings by clicking 2] (Set) in the
Camera Window and selecting [Slide/DPOF] in the next menu.

o Edin SdedDBOF - Canon Camera

= Shie Shiea
Pient Qe [1 PO

How to set up a slide show

Click the [Camera] menu in the main window and select [Edit
Slide/DPOF]. Click the [Slide Show] button at the top left of the |

next window and select the number of the slide show you wish From the image list on the left, drag images to
the right area and then arrange their sequence

to edit. for the slide show.

: When you are done arranging the slide sequence, click [Save to
v St Shiny 7 ¥ 4 Camera] to save the slide show setup.
— Pt OideriIIPOF] Eilit Halp et
: : s REFERENCE
e = e [f you want to change the sequence of some images, just drag

them to the right place in the area on the right.
e |[f you want to remove an image from the slide show, select the
Select a slide show number. image. On the [Edit] menu, click [Clear].

121 ZoomBrowser EX Software User Guide




Appendices Print SEttingS (1 / 2)

You can use ZoomBrowser EX to register print settings on a memory
card, including the images to print and the number of copies.

IMPORTANT

e This feature does not work with unconverted RAW images. If
you want to print RAW images, convert them first, copy them to
the camera and perform this operation.

e Ensure that the camera and computer are connected with an
interface cable and that the camera is ready to transfer data
before you perform this procedure.

REFERENCE

* DPOF is a standardized format for recording print settings, such
as the image selection and number of copies. After DPOF print
settings have been set, you can take a memory card to a camera
store or developing laboratory and have the images printed
according to the settings.

® You can also set the print settings by clicking ﬂ (Set) in the
Camera Window and selecting [Slide/DPOF] in the next menu.

How to make DPOF print settings

Click the [Camera] menu in the main window and select [Edit
Slide/DPOF]. Click the [Print Order (DPOF)] button at the top left
of the next window and select the print type.
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W Edin StidedDROF - Canpn Camera
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Select the print type.

I Standard Print

Prints the specified number of copies of the images that you
selected.

¥ Index Print

Prints only thumbnails of the images that you selected.

M Both (Standard/Index)

Prints the specified number of copies and thumbnails of the
images that you selected. In addition, it produces an index print
of small versions of all the images.

REFERENCE

You can also click [Edit] and then click [Include in index print] to
include the image date and file number in the prints.




Appendices

Print Settings (2/2)

Standard printing

123

The number under each image indicates the number of copies
to print. Use the arrows next to the boxes to select the number
of copies you want.

1 Edi StideAE0OF - Canon Camera
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The standard print icon displays when Specify number of
a number of copies is specified. copies to print.

When you are done with your selections, click [Save to Camera]
to save the information.

REFERENCE

e The procedure explained above also applies when the print type
is “Both (Standard/Index)".
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Index printing

To include images in an index print, select the check box under
the image.

W Edit StidedDBOF - Canon Camera
Shin Shins
' Pant Qe[ POF)

Select the check box to include
the image in the index print.

The index print icon displays when a
check mark is added to the image.

When you are done with your selections, click [Save to Camera]
to save the information.




Appendices TrOUbleShOOting (1 /4)

This section explains how to troubleshoot problems.

The event dialog box does not appear

The dialog below fails to appear even though the camera is
correctly connected to the computer via the interface cable and
ready to transfer data...
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Or, a message, such as “No camera was found”, appears when
you attempt to download images from the camera...
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In either case, confirm the status of each of the following items
in order.

IMPORTANT

e \With some versions of Windows, this dialog may not appear the
very first time the camera is connected to the computer after it
is booted up. (It will display subsequently.)

In that case, use either of the following procedures.

e Start ZoomBrowser EX
Double-click the [ZoomBrowser EX] icon on the desktop.

e Connect the Camera
Click the [Start] menu and select [Programs] or [All Programs],
followed by [Canon Utilities], [CameraWindow] and
[CameraWindow].

W Check your Computer

Ensure that your computer meets the following requirements.

ZoomBrowser EX will not operate on computers failing to meet

these requirements.

e Built-in USB ports on a computer pre-installed with Windows XP,
Windows 2000, Windows Me, or Windows 98 (First or Second
Edition).

W Check the Connection between the Camera and Computer

Confirm that the camera is correctly attached to the computer
with an interface cable. For information on the connection,
refer to the documentation that comes with the camera.




Appendices

Troubleshooting (2/4)

B Check the Camera Status If You Were Using ZoomBrowser EX Version 2 or 3

Confirm that the camera is on and in the correct mode to
transfer data. Because the procedures for preparing the camera
for communication differ among camera models, refer to the
documentation that accompanied your camera for more
information.

M Check the battery

You are recommended to use a household power source (AC
adapter) for the camera when connecting it to the computer. If
the camera is running on batteries, ensure they are fully
charged.

If the problem does not rest in the four areas above, the driver
may not be properly installed. Uninstall the driver and then
reinstall it. For instructions for this task, refer to the Software
Starter Guide.

REFERENCE

e The Events dialog will not display when a memory card reader is
used.
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Images Were Assigned Titles or Comments

Use the following procedures to display titles and comments
previously input in ZoomBrowser EX Ver. 2/3.

Start Windows Explorer by clicking the [Start] menu
and selecting [All Programs], followed by [Accessories]
and [Windows Explorer].

(With Windows 2000/Windows Me/Windows 98, right-click the

[My Computer] icon and select [Explore] from the popup
menu.)

Open the [Program] folder

inside the folder into which | 570 = ™% = &
ZoomBrowser EX 4 was T e e ————
installed. s =
For example, open the folder to the "j — e
right if the following path is correct: @ sty -
[C:\Program Files\Canon\ZoomBrowser | | & msmessein
EX\Program]. iy 8
i 3
_H::-\-l-.:.-\.:-l E|




T Troubleshooting (3/4)

3_ Double-click the [dbconverter.exe] or [dbconverter] 5_ Click [OK] if the following dialog appears.

file in that folder.

1
oF sl
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4. Select the database file that was used with the

previous version of the program and click [Start]. Click IC] hen the dialod in Step 4

For example, select the following database file if it was used 6- '_C [ Qse] W en the dialog in tep. appears.

EX\Database\My Database.zbd]. input in version 2 or 3. The titles and comments will appear

together in the Comments section of ZoomBrowser EX 4.
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Appendices

Troubleshooting (4/4)

127

B Image Files Were Saved Below the Program Files

Folder in a Previous Version

In ZoomBrowser EX 4, image files in folders within the Program
Files folder will not display. To display these images, perform the
procedures below after you have followed steps 1-6 on the
previous page.

Use Windows Explorer to copy the image folders
within the Program Files folder and paste them in
another folder higher in the directory hierarchy.

For example, if a folder called the [Image Library One] folder is
in the Program Files folder, move it to a higher location, such as
the [C:\] drive.
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IMPORTANT

e Do not copy just the images from within the folder, copy the
folder itself to a location higher in the directory hierarchy.

When you select the copied folder in ZoomBrowser EX 4, the
images will now display.

5 ormm i ey e - . I :

Vg B s bEn e

Click the copied folder to display its images in the
Browsing Area.
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Index (1/3)

Adding Computer Images to the Camera

71, 78

Adobe RGB color space 12, 23, 28

Auto-Download Settings 114

Brightness 41

Browsing Area 22, 23, 32
Selecting Folders 31

Buttons

Browse & Download Images 8, 23
Camera & Memory Card 8, 23, 24, 65

Clear All 26

Close 18, 42

Connect to Internet 28
Delete 26, 29
Deselect 29

Download Image 28
Download image 66
Function Buttons 26, 29
Help 18, 29

Internet 24

Print 12, 24, 28
Properties 26, 29
Return to Main Menu 24
Rotate 26, 29, 52, 70
Save As 42

Select 29

Select All 26, 45

Set 29, 71

Task Buttons 24, 28
Thumbnail Size 26, 32
Up 26, 35

View & Modify 24
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View as Slideshow 28
View Image 26, 37
View Mode 26, 32
Zoom-In 26
Zoom-QOut 26

Camera Settings 85
Camera Window 28, 64
Opening 64
Changing the Display 27
Close box 17
Color 41
Computer
Slide Show 82
Contrast 41
Copying Images 47
Crop 40
Customizing Menus 120

Deleting
Camera Images 69
Folders 59
Images 50
Deselect Image 45
Display Mode 32
Displaying
Changing the Display 27
Images 37
Downloading Images 66
DPOF 122

E-mail 76
Edit Panel 39
Editing
Images 39
Sounds 93
Events Dialog 5
Events dialog 124
Exif 2.2 (Exif Print) 17
Exit 18
Export 80
Exporting Images 80

Finding
Folders 22, 61
Images 21
Folder
Creating 44
Deleting 59
Finding 61
Properties 61
Refreshing 58
Renaming 60
Selecting 31, 34
Folder Area 22, 23, 31
Selecting Folders 31
Format 72, 79, 113
Function Buttons
Camera Window 28, 29
Main Window 23, 26

Help 18
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Adding Sounds 84
Adding to the Camera 71
Copying 47
Deleting 50
Deselecting 45
displaying 37
Downloading 8
Editing 39
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Properties 62
Renaming 53
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Searching 55
Selecting 45
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Zooming 38

Index Print

DPOF 122

JPEG Format 113

Keywords 57
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Main Window 23
Menu
Customizing 120
Movies 68, 95
Editing 96
Exporting 100
Playing 95
Moving Images 46
My Camera Settings 86
Creating files 90
Saving to the Camera 92
My Camera Sound 93
My Camera Sound Maker 93
My Camera Window 86
My Pictures Folder 21

New Folder 44

Opening Images 37
Owner's Name 85

PhotoCD format 113
PhotoRecord 13, 20
PhotoStitch 20, 111
Play Sound 84
Preferences 117
Preview Mode 33
Print Settings 122
Print/Share Button 10
Printing 12
Properties

Folder 61

Image 62

QuickTime Format 113
QuickTime Player 95

RAW Format 68, 113
Converting 102
Reconnect 75
Recording Sounds 93
Redo 42
Remote Shooting 107
Interval Timer Shooting 109
Timer Shooting 109
Renaming
Folders 60
Images 53
Right-Click 30
Rotating
Camera Image 70
Images 52
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Save As 42
Saving Images

CD-R/RW 112

Save As 42
Scroll Mode 33
Searching Images 55
Select All 45
Selecting

Display Mode 32

Images 45
Set Button 29, 71
Shooting Information 62
Slide Shows

Camera 121
Sorting Images 54
Sounds 84

File Length 90

Saving Sounds 94

Sound Memo 68
Standard Print 122, 123
Starting ZoomBrowser EX 4
Stitch Assist Mode 68, 111
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Task Area
Camera Window 28
Main Window 23, 24
Using the Task Windows 25
Task Buttons
Camera Window 28, 73
Main Window 24
Theme 87
Thumbnails 22
TIFF Format 113

Undo 42
Video clip files 113

Window
Camera Window 28, 64
Main Window 7, 23
Switching 23

Windows Bitmap Format 113

Zoom In/Out 36
Zoom Mode 32
ZoomBrowser EX
Exiting 18
Starting 4
Zooming 38
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Disclaimer

* While every effort has been made to ensure that the information contained in this guide is accurate and complete, no liability
can be accepted for any errors or omissions. Canon reserves the right to change the specifications of the hardware and software
described herein at any time without prior notice.

* No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language
in any form, by any means, without the prior written permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to a mistaken operation or malfunction of
the camera, the software, the CompactFlash™ cards (CF cards), personal computers, peripheral devices, or use of non-Canon CF
cards.

Trademark Acknowledgments

e Canon and PowerShot are trademarks of Canon Inc.

¢ Adobe and Photoshop are trademarks of Adobe Systems Incorporated.

* ArcSoft, the ArcSoft logo, ArcSoft PhotoStudio, ArcSoft Photolmpression and ArcSoft Videolmpression are trademarks
or registered trademarks of ArcSoft, Inc.

e CompactFlash is a trademark of SanDisk Corporation.

e Quick Time is trademark of Apple Computer Inc., registered in the United States and other countries.

e Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States
and/or other countries. Microsoft® Windows® 98, Microsoft® Windows® 2000, Microsoft® Windows® Millenium Edition,
and Microsoft® Windows® XP are referred to in this guide, respectively, as Windows 98, Windows 2000, Windows Me,
and Windows XP, or as Windows.

e Netscape and Netscape Navigator are trademarks or registered trademarks of Netscape Communications Corporation in the United
States and other countries. Netscape Communicator is a trademark of Netscape Communications Corporation.

¢ Other names and products not mentioned above may be registered trademarks or trademarks of their respective companies.
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